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3.
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5.
6.
7.
8.
9.

10.

11.
12.
13.
14.
15.
16.
17.
18.

1 Summary of the Axxon PSIM utilities
Additional Axxon PSIM software utilities are separate software applications intended to perform additional 
operations when setting up and working with Axxon PSIM software. This document describes the following utilities:

The utility for reading video capture card code and dongle
Converter.exe utility for converting video and audio archives
Tweaki.exe utility for advanced setup of the Axxon PSIM software system
The utility for collecting configuration data on servers and RWS for the Technical Support
The Fps.exe utility for productivity estimation
The SignCheck.exe utility for checking the authenticity of exported frames
The Convert.exe utility for correcting modification dates of video archives
The ddi.exe utility for editing database templates and external settings files
The Arpedit.exe utility for creating user dialog windows
The idb.exe utility for converting databases, selecting database templates and making backup copies of 
databases
Configuration check tool
Index.exe utility for reindexing archive files
The shedule.exe utility for creating a replication query file
The AxxonPSIM player utility for viewing and converting the video archive
The SyncProtocol.exe utility to synchronize event log database
The openRTSP.exe utility for checking RTSP workability
The Automatic Update Service
ArchProbe console utility
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1.

2.

2 The utility for reading video capture card code and dongle

2.1 The purpose of the CodeReader.exe utility
The CodeReader.exe utility is designed to read the dallas code of the cryptochip (chip) of the video capture card, 
which determines the card type, HID of computer and the number of the Guardant or MatrixLock dongle.

2.2 Starting and shutting-down the utility
To start the CodeReader.exe utility, do one of the following:

Start the utility from the Windows taskbar. Click Start, then All Programs, then Axxon PSIM, then Tools, 
then Read hardware codes. The CodeReader.exe utility is available for the following types of Axxon PSIM™ 
installation: Server and Remote Admin Workstation.  

Start the utility from the Tools folder of the Axxon PSIM folder. Example: C:\ Program Files\Axxon 
PSIM\Tools\CodeReader.exe.

The Code Reader dialog box will open.

Note.

 For proper operation of the utility Axxon PSIM™  is to be shut down.
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To shut down the CodeReader.exe utility, click the   button.

2.3 Using the CodeReader.exe utility
The CodeReader.exe utility allows determining the type of installed video capture card by its dallas code(s), HID of 
computer, as well as the number of the Guardant or MatrixLock dongle. To read this information, start the utility 
(see the Starting and shutting-down the utility section). The type of video capture card, its dallas code(s) and the 
number of the Guardant/MatrixLock dongle and HID will be displayed in the Code Reader dialog box.

 

The number of dallas codes depends on the number of chips on the video capture card. Figure shows that the FS6 
card with 4 chips has been used.
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2.4 Portable version CodeReader_portable.exe
The portable version of the utility for reading the video capture card codes and dongles is the executable file 
CodeReader_portable.exe. This file can be downloaded from the official AxxonSoft website.

The CodeReader_portable.exe file can be launched on any computer even without Axxon PSIM installed.

The purpose and interface of the portable version, as well as the procedure for working with it are similar to the 
standard version of the CodeReader.exe utility – see The utility for reading video capture card code and dongle.

Attention!

For the portable version of the utility to operate, you need to install the latest versions of the Visual C++ 
redistributable packages for Visual Studio. 
To check the availability of the Visual C++ redistributable packages for Visual Studio, select Start -> 
Control Panel -> Programs -> Programs and Features.

If there are no redistributable packages, you can download them from the official website at: https://
learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170, or install the file that 
is available in Axxon PSIM installation directory in the Redist -> Dotnet4.5 folder.

https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170
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1.
2.

3 Converter.exe utility for converting video and audio archives

3.1 The purpose of the Converter.exe utility

The Conveter.exe utility is designed to play video and audio archives, and to convert them to standard formats: 
MPEG, DivX, etc.

Besides video and audio playback, Converter.exe utility is used for:

Converting audio and video files.
Copying the files from the archive to another folder with no data loss.

The utility can be started from the Tools folder of the Axxon PSIM program folder or from the Start menu: Start -> 
Programs -> Axxon PSIM -> Utilities -> Playback and Conversion.

The utility dialog box is shown in the figure.

Important!

Correct operation of the Converter.exe utility on Windows 10 and newer OSes is not guaranteed.

Note.

 If video and audio were synchronized at the time of recording, the converted video file will contain sound 
track.
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1.

2.

3.2 Starting and shutting-down the Converter.exe utility
To start the Converter.exe utility, do one of the following:

Start the utility from the Windows taskbar. Click Start, then Programs, then Axxon PSIM, then Video player 
and file converter. The Converter.exe utility is available from the Start menu with the following installation 
types of the Axxon PSIM software: Server, Remote administrator workstation, Remote client.

Start the utility from the Tools folder of the Axxon PSIM program folder. Example: C:\Axxon 
PSIM\Tools\converter.exe.

Archive Converter dialog box will open.



PSIM 2.0 (english) – Additional utilities for the Axxon PSIM software

Converter.exe utility for converting video and audio archives– 15

 

To close the Converter.exe utility, either click the cross button in the top right corner of the dialog box, or press 
Alt+F4 on the keyboard.

3.3 Converter.exe interface

3.3.1 The Archive's Converter dialog box
The dialog box of the converter.exe utility is shown in the figure.
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1.
2.

 

The Archive's Converter dialog box comprises of the following elements:

The screen to play back recordings (1);
The control panel for video and audio recordings playback (2). 
The elements of the control panel are described in the table.

№ Element name Description

1 Recording start date and time Fields for entering the approximate start date and time of the 
video or audio recording

2 Recording end date and time Fields for entering the approximate end date and time of the 
video or audio recording
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№ Element name Description

3 Go to first / last frame Buttons for quick moving of the slider to the beginning or the 
end of the recording

4 Device Drop-down list field for selecting the device (camera, 
microphone), for which the recording should be found in the 
archive

5 Device number Drop-down list field for selecting the number of the device, for 
which the recording should be found in the archive

6 Search Button for starting the search of recordings in the archive of the 
chosen device. The recordings are searched in the entire archive 
of the device. After the search is completed it is possible to 
specify the approximate beginning ang end date and time for 
required recording

7 Playback panel The panel contains typical standard functions (from left to 
right): backward, play, pause, stop, forward

8 Time scale The scale allows monitoring the playback progress and moving 
between the frames. To move between the frames, drag the 
slider or use the playback panel buttons in a per frame playback 
mode

9 Export setup The button for opening the Export Setup dialog box

10 Exported recording limits The buttons for setting the first and the last frames of the 
exported record

11 Hide/show the list The button for hiding and showing the list of selected 
recordings

12 Add to list The button for adding the selected recording (recording 
segment) to the list

13 Print frame The button prints the current frame

14 Frame export The button exports the current frame in a specified format. A 
dialog box opens for selecting the folder on the disk and 
entering the file name
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№ Element name Description

15 Export to AVI or archive The button for starting the export of the recording (a recording 
segment) in the specified format. A dialog opens for selecting 
the device name, which made the recording. On export start, a 
folder is created for saving the exported recordings (by default, 
C:\Backup)

3.3.2 The Export Settings dialog box

To open the Export Settings dialog box, click the  button in the Archive's Converter window. The Export 
Settings dialog box will open, allowing to specify export parameters.

N
o

Parameter 
name

Field type Description Form
at

Default value Value range

The Choose folder group
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N
o

Parameter 
name

Field type Description Form
at

Default value Value range

1 Destination Type-in the 
value

Type-in the folder on the 
disk to store the 
exported files (by default 
the Backup folder is 
created on disk C:)

- - -

2 Volume Size, 
MB

Type-in the 
value

Type-in the maximum 
value of the volume (file) 
size containing one or 
more recordings.

If the size of recording for 
export exceeds the set 
one, then it will not be 
split.

When the recording is 
added to the volume, the 
size of recording is 
expected to equal the 
mean value of sizes of all 
added recordings. A new 
recording is added to the 
volume if it does not 
exceed the volume size. A 
real size of recording can 
differ from the assumed 
one, therefore the 
volume size can exceed 
the assumed one.

If the Break To Alarms
checkbox is checked, 
each volume will contain 
one recording only. The 
field is disabled if the 
Native Archive
parameter is activated

MB 650 0 to 2000 MB

3 Frames per 
second

Select in a 
drop-down 
list

Type-in the amount of 
grooming of the video 
recording

fps RealTime 0.5; 1; 3; 5; 15; 30; 
RealTime
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N
o

Parameter 
name

Field type Description Form
at

Default value Value range

4 Native 
Archive

AVI File

Select a 
radio-button

If the Native Archive
radio-button is selected, 
then  archive fragments 
will be exported keeping 
the creation time, but 
with no AVI conversion. If 
the AVI File radio-button 
is selected, then the 
fragment is converted to 
the AVI format using the 
specified codec

- AVI File Native 
Archive
AVI File

5 Break To 
Alarms

Checkbox The checkbox is for 
selecting the way of 
storing the archive 
export fragments to 
volumes (files of 
specified size): the 
recordings for each 
alarm will be saved to 
separate volumes (files)

- Unchecked Unchecked – the 
file (volume) will 
contain a fragment 
of the size specified 
in the Volume Size, 
MB field

Checked – the 
volume will contain 
a fragment related 
to one alarm only
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1.

2.

N
o

Parameter 
name

Field type Description Form
at

Default value Value range

6 Native 
Format

Checkbox If the Native Format 
checkbox is checked, 
then video recordings are 
exported to AVI file 
without recompression, 
i.e. in the same format as 
in Axxon PSIM archive. To 
playback these AVI files 
on the computer without 
Axxon PSIM software 
package installed, install 
components from Axxon 
PSIM distributive 
beforehand:

\Redist\VC2005_S
P1\vcredist_x86.e
xe
\Redist\CamMonit
or\CamMonitorIns
taller.exe

Note. To playback AVI 
files use Windows Media 
Player

- Unchecked Unchecked – Axxon 
PSIM archive is 
exported to AVI file 
with recompression

Checked - Axxon 
PSIM archive is 
exported to AVI file 
without 
recompression

The Frame Export group

7 Bitmap

Jpeg

Select a 
radio-button

 If the Bitmap radio-
button is selected, then 
the file is saved in Bitmap 
format.  If the Jpeg radio-
button is selected, then 
the file is saved in Jpeg 
format

8 Quality Set the slider The parameter specifies 
the quality level of the 
exported file. The value 
of 100% results in no 
quality loss

% 80 0 to 100

The Compression group
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N
o

Parameter 
name

Field type Description Form
at

Default value Value range

9 Video Click the 
button

The button is for 
selecting and setting up 
the video codec used to 
compress video 
recordings. If the Native 
Archive radio-button is 
selected or the Native 
Format checkbox is 
checked, then this 
button is disabled

- -

1
0

Field next to 
the Video 
button

Not to be 
edited

The field shows the info 
on selected video codec. 
If the Native Archive
radio-button is selected, 
then this field is disabled

- Full Frame 
(Uncompr-
essed), 
Quality: 0

The list of codecs 
found by the utility

1
1

Audio Click the 
button

The button is for 
selecting and setting up 
the quality of the 
exported audio. The 
Native Archive radio-
button is selected, then 
this button is disabled

- - -

1
2

Field next to 
the Audio 
button

Not to be 
edited

The field shows the 
selected audio format

- PCM, 8000 
kHz; 16 bit; 
Mono

The list of quality 
levels detected

The Screen group

1
3

Overlay Checkbox If the Overlay checkbox 
is checked, there is 
DirectDraw conversion

- Checked Checked – use 
DirectDraw for 
conversion

Unchecked – do not 
use DirectDraw for 
conversion

1
4

Always On 
Top

Checkbox If the Always On Top
checkbox is checked, 
then Converter window 
is always over all other 
windows

- Unchecked Checked – the 
window is 
displayed on top

Unchecked – the 
window is not 
displayed on top



PSIM 2.0 (english) – Additional utilities for the Axxon PSIM software

Converter.exe utility for converting video and audio archives– 23

N
o

Parameter 
name

Field type Description Form
at

Default value Value range

1
5

Keep Aspect 
Ratio

Checkbox If the Keep Aspect Ratio 
checkbox is checked, the 
aspect ratio of Converter
window is fixed

- Unchecked Checked – 3:2 ratio 
is kept when the 
size of the dialog 
box is changed

Unchecked – 3:2 
ratio is not kept 
when the size of the 
dialog box is 
changed

1
6

Split AVI files Checkbox Activates export of 
selected video 
recordings to the 
separate AVI files.

Note. If the checkbox is 
not checked, video 
recordings from one 
camera are exported to 
one AVI file

- Checked Checked - video 
recordings are 
exported to the 
separate AVI files

Unchecked – video 
recordings are 
exported to one AVI 
file

1
7

Digital 
signature

Checkbox Activates adding digital 
signature that is used for 
checking frame 
authenticity to exported 
frames.

Note. Checking frame 
authenticity is performed 
using SignCheck.exe 
utility (see The 
SignCheck.exe utility for 
checking the authenticity 
of exported frames and 
video recordings section)

- Unchecked Checked – digital 
signature is added

 Unchecked – 
digital signature is 
not added

If a microphone was selected as a device in the dialog box of Converter.exe utility, only the Audio button and the 
Screen group are enabled.

3.3.3 A dialog box for choosing the video codec
The Video button in the Export Setup dialog box opens a dialog box for choosing a video codec to be used for video 
compression.
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N
o

Para
meter 
name

Field 
type

Description Form
at

Default 
value

Value range

1 Comp
ressor

Select 
from 
drop-
down 
list

The button allows selecting and setting up the 
video codec used to convert and compress the 
video image

Code
c 
name

Full 
frames 
(no 
compre
ssion)

All video 
codecs 
recognized by 
the operating 
system

2 Comp
ressio
n 
qualit
y

Drag 
the 
slider

The slider allows setting the compression level. 
The zero position of the slider represents the 
highest compression and lowest quality. 
Changing this parameter is enabled if the codec 
is selected in the Compression Program field

% 0 0 to 100

3 Config
ure

Click 
the 
button

The button opens the settings panel of the video 
codec.  See the codec manual for details

- - -

4 About Click 
the 
button

The button opens an information box with 
codec details

- - -

3.3.4 A dialog box for choosing the audio format
The Sound button in the Export Setup dialog box opens a dialog box for choosing an audio format.

Note.

 If AVI format is used, the resultant file size should not exceed 2 GB.
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N
o

Parameter 
name

Field type Description Format Default 
value

Value range

1 Name Select from 
drop-down list

The field allows 
choosing the name 
for the selected audio 
format

Format 
name

Untitled Untitiled

CD Quality

Radio Quality

Telephone Quality

Compact disk

2 Format Select from 
drop-down list

The field for selecting 
the format

Format 
name

PCM The list of audio 
formats used by 
the utility

3 Attributes Select from 
drop-down list

The list of sound 
characteristics: 
playback/recording 
frequency (8000 kHz), 
digitizing level (8, 16, 
etc bits), channel type 
(mono/stereo)

Parame-ter 
values

PCM, 8000 
kHz, Mono

The list of 
characteristics, 
recognized by the 
operating system
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2.
3.
4.
5.
6.
7.
8.

1.

N
o

Parameter 
name

Field type Description Format Default 
value

Value range

4 Save as… Click the 
button

The button allows 
creating a unique 
name for the selected 
format. To save a 
format under a 
unique name:

1. Select Untitled in 
the Name field.

2. Select the values in 
the Format and 
Attributes fields.

3. Click the Save As
button

4. Enter a unique 
name in the Save 
This Format As field 
and click OK.

The newly created 
name will appear in 
the Name drop-down 
list. 

String - -

3.4 Using the Converter.exe utility

3.4.1 General description of the Converter.exe utility
The Converter.exe utility is designed to convert and play back audio and video recordings from the archive and save 
them to a specified folder.

Using the Converter.exe utility includes:

Starting the utility (see Starting and shutting-down the Converter.exe utility).
Selecting an archive (see Selecting an archive to be played or converted).
Finding a recording in the selected archive (see Selecting an archive to be played or converted).
Playback of the recording (see Recording playback).
Finding the required recording fragment or frame (see Searching for a video recording).
Setting the export or conversion parameters (see Converting video and audio archives to AVI files).
Exporting the fragment or printing the frame (see Exporting recordings and frames).
Shutting-down the Converter.exe utility (see Starting and shutting-down the Converter.exe utility).

3.4.2 Selecting an archive to be played or converted
To search an archive for a recording, do the following:

Select the device the recording was made by, and its number (1).
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2.

3.

4.
5.

Click the Search button (2).

Select the location of the archive (folder with archives for specific date and time) on an appropriate disk.

Click the  button.
Specify the time limits in the date/time fields (3).

The first frame of the required recording will be displayed in the video playback screen.

Note.
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2.

3.

4.

5.

1.

2.

3.4.3 Searching for a video recording
After the approximate time interval is selected using the date/time fields, and the required archive is found, it may 
be necessary to find a particular fragment or frame to be played or exported.

Searching for a fragment in a recording
To find the required video fragment in the selected recording, do the following:

Click the Play ( ) button in the playback control panel.

When the required fragment appears, click the Pause ( ) button.

Click the Fragment Start ( ) button to make the current frame the start of the fragment.

Click the Play ( ) button in the playback control panel.

When the required fragment ends, click the Fragment End ( ) button to make the current frame the end 
of the fragment. All subsequent frames will be omitted.

The resultant recording fragment will then be available for conversion or export, maintaining the format and the 
creation date.

Searching for a frame in a recording
To find a particular frame in the selected recording, do the following:

Click the Play ( ) button in the playback control panel.

When the required frame appears, click the Pause ( ) button to enter the per frame playback mode.

In case of searching for an audio recording, no visible signs of finding the recording will be shown. To 
check that a recording was found, play it.

Note.

Speed of records search directly depends on their number. The search process can take a lot of time if the 
archive depth is rather big and reading is performing from the network disk. 

•

•

Note.

If video files that are to be opened were not recorded, but copied, then start the Convert.exe utility to open 
the archive (see The Convert.exe utility for correcting modification dates of video archives section):

If the archive is created in the same time zone as it is viewed, then start the utility with the fullmode 
parameter:
convert.exe fullmode

If the archive is created in different time zone than it is viewed, then move the archive to the 
current time zone by starting the utility with the following parameters in the command prompt: 
convert.exe fullmode TZ +hh:mm 
where +hh:mm is the time shift between the current time zone and the time zone of the archive.

Otherwise, the folders with video files fail to open.
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1.

•

•

2.

3.

4.

5.

6.

1.
2.
3.

Keep clicking the Fragment Forward ( ) and Fragment Back ( ) buttons, to browse the frames until 
the required frame appears on the screen.

The resultant frame may be printed or used as a starting frame for a fragment (see Searching for a fragment in a 
recording section).

3.4.4 Recording playback
The recording selected by date and time, can be played in Converter.exe player using the playback control panel.

The panel contains five control buttons (left to right on the figure): Back, Play, Pause, Stop, Forward, allowing to 
play, pause, stop and browse the records.

If the Stop button is down (clicked), then it is possible to move between the recording segments by clicking 
the Forward or Back buttons. The recording segment means one of the following:

a segment of video recording between the commands to start and stop recording if the recording was 
initiated manually (for example, via a script or the camera's context menu);
a segment of video recording between the beginning and the end of the detection tool triggering, 
taking into account the periods of pre- and post-recording in case the recording was initiated by any 
detection tool.

A short press of the Play button starts playing the recording segment from start to end. If the recording 
contains several recording segments, the Play button should be clicked to play each of them. 
To play a record consisting of several segments without stopping, press and hold the Play button for 1-2 

seconds. The button then changes its appearance from  to . To stop playback, click Stop.
To play the recording in the frame-by-frame mode: a) click Play, b) click Pause, c) keep clicking Forward or 
Back to view frames one by one.
To view the recording segment in accelerated mode click the Play button and then click the Forward to 
accelerate twice relatively the previous speed. The current playback speed is displayed in titles above video 
image.
To view the record section in slow motion, click the Play button and then click the Back to slow down twice 
relatively the previous speed. The current playback speed is displayed in titles above video image.

3.4.5 Converting video and audio archives to AVI files
Video and audio archives are converted into AVI format according to Converter.exe settings, using the Export Setup
dialog box. The level of compression of the exported recording is determined by the following parameters:

Frames Per Second parameter – setting the parameters of the recording grooming;
Video button – selection of the video codec, in case of video archive export;
Sound button – set the sound quality parameters (frequency, bitrate, etc), in case of audio archive export.

Note.

If the recording is to be played back in the per frame playback mode starting with the first frame, 

then click the Pause ( ) button instead of the Play ( ) button.

Note.

To quit the per frame playback mode, click the Pause ( ) button once more.
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e.

3.4.6 Exporting recordings and frames
Export of the recordings is one of the main functions of the Converter.exe utility. There are two ways of exporting 
records from an archive:

Export to AVI option converts (compresses) a recording and breaks it down into volumes (files of the size 
specified in the Export Setup dialog box).
To export the recording as AVI, do the following:

Find the recording in an archive (see the Selecting an archive to be played or converted section).
In the Export Setup dialog box, select the Export to AVI radio-button.
Click the Video or Sound button to specify the conversion parameters. Click the OK button.

Click the Export to AVI/Archive button ( ) to start exporting.
Enter the name of the device folder to save the recording to (1), then click Continue ( 2).

The export progress will be shown in the title bar of the Converter.exe window.

Note.

 If AVI format is used, the resultant file size should not exceed 2 GB.
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1. a.
b.

c.

The title bar will read Complete, when exporting is completed. To verify the results, open the Backup 
folder and find the file named after the device from which archive the recording was exported.

The Export to Archive option allows copying the files from an archive to another location on the disk with no 
conversion, maintaining the recording creation date and an option for breaking it down into volumes.
To export a recording in the same format as it is stored in the archive, do the following:

Find the recording in the archive (see the Selecting an archive to be played or converted section).
In the Export Setup dialog box, select the Export to Archive radio-button.
Specify volume size in the Export Setup dialog box. Click the OK button.

Click the Export to AVI/Archive button ( ) to start exporting.

The Converter.exe utility allows exporting frames into bitmap and JPEG formats. Do the following:

Find the required frame (see the Searching for a frame in a recording section).
In the Export Setup dialog box, specify the parameter values in the Frame Export group. Click the 
OK button.

Click the Export Frame button ( ).

Note.

 If AVI format is used, the resultant file size should not exceed 2 GB.
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d.
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Specify the location to save the exported file to in the Save As dialog window.

The file name will be generated automatically in the following format: 1) name and number of the 
camera where the frame comes from; 2) creation date; 3) creation time. The file extension 
corresponds to the file format selected in the Export Setup dialog box.
Click the Save button.

3.4.7 Using a command prompt to work with the Converter.exe utility
Video and frames can be exported with the help of a command prompt using the following commands:

Converter.exe Disc:\File,Number_Cam,StartDate StartTime,StopDate StopTime,CameraName

Converter.exe Disc:\File,Number_Cam,StartDate StartTime,,CameraName

The table describes the command parameters.

Parameter Description

Disk Disk for storing exported files

Note.

If StopDate and StopTime parameters are not specified, then ‘,’ is to be specified instead.
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File Name of a catalogue or file.

Note 1. If the catalogue or file specified in the command does not exist, it will 
be created automatically.

Note 2. To export archive (video record in the original format) only catalogue 
name is to be specified.

Number_Cam Number of a camera which performs the recording

StartDate Date of record start (dd-mm-yy)

StartTime Time of record start (hh:mm:ss)

StopDate Date of record end (dd-mm-yy).

Note. Parameter is not in use while exporting the separate frames

StopTime Time of record end (hh:mm:ss)

Note. Parameter is not in use while exporting the separate frames

CameraName Name of the camera that is to be displayed in the titles on the exported 
video, as well as the name of the folder created in the specified export folder 
used for storing exported files

The example of using the command prompt to export files is shown in the figure.

As a result the “export” folder containing the exported files is created on the local disk “C”.
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3.4.8 Printing a frame
To print a frame, do the following:

Find the required frame (see the Searching for a frame in a recording section).

Click the Print Frame button ( ).
A standard dialog box for printing and printer setup will be opened.

3.4.9 Exporting video with titles
Video with titles is exported as follows:

Run the Converter.exe utility (see Starting and shutting-down the Converter.exe utility).
Call for Export Settings dialog window in the opened window of Converter.exe utility and set its groups 
Choose folder, Frame Export, Compression and Screen (see. Interface description of The Export Settings 
dialog box).



PSIM 2.0 (english) – Additional utilities for the Axxon PSIM software

Converter.exe utility for converting video and audio archives– 35

3. Set the titles displaying in the Titles group in the dialog window Export Settings; table shows parameters 
description of the given.

№ Parameter name Parameter description Value range

1 Point of sale 
dropdown list

Name of cash terminal, titles from 
which should be laid over the video 
recording while viewing and 
exporting the frames and recordings 
with the help of Converter.exe utility

Empty value – titles from all the 
titrates overlay function.

No – overlay function is off.

Number of cash terminal (from 
one and above) – function of 
displaying the titles concerning 
the given cash terminal.
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2 Checkbox Name, 
Date, Time

When the given checkbox is 
activated, lines, containing name 
and number of a camera, date and 
time of creation of the given video 
frame, will be laid over the video 
recording

Yes – lines, containing name and 
number of a camera, date and 
time of creation of the given video 
frame , will be laid over the video 
recording.

No – lines, containing name and 
number of a camera, date and 
time of creation of the given video 
frame , will not be laid over the 
video recording.

3 Editing text fields X, Y, 
W, H

Coordinates and area size, taken by 
titles in the video recording. Is 
expressed in percentage relative to 
the screen size of video recording 
playback

From 0 and above.

Depends on the screen size of 
video recording playback.

4 Font button Font selection of titles displaying -

To apply the settings it is necessary to click OK button. To cancel settings one should click the cross mark in 
the upper right corner of Export Settings dialog window.
Dialog window of Converter.exe utility for exporting the required file will open in result (see Exporting 
recordings and frames).

Export of video recordings with titles is completed.

Note.

 If the cash terminal is selected, its value will not be saved with the repeated run of Converter.exe 
utility. On default displaying titles from all the titers is set.
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4 Tweaki.exe utility for advanced setup of the Axxon PSIM 
software system

4.1 The purpose of the tweaki.exe utility
The tweaki.exe utility is used for configuring Axxon PSIM by editing the sections of the Windows registry, where the 
setup parameters for the Axxon PSIM core and modules are stored:

For 64-bit systems, the sections are HKLM\SOFTWARE\Wow6432Node\AxxonSoft and 
HKCU\SOFTWARE\Wow6432Node\AxxonSoft.
For 32-bit systems, the sections are HKLM\SOFTWARE\AxxonSoft and HKCU\SOFTWARE\AxxonSoft.

The utility should be run as the same Windows user who is used to start Axxon PSIM, otherwise the new settings may 
not apply. This is because the choice of the Windows account determines to which registry section the changes will 
be written.

The tweaki.exe utility provides the following functionality:

Setup of Axxon PSIM startup (see The Settings panel of the Windows section);
Enabling the debug mode of Axxon PSIM (see Enabling and configuring the debug mode of Axxon PSIM);
Advanced setting of the Video surveillance monitor (see The Settings panel of the Video subsystem section);
Advanced setting of events logging (see The Settings panel of the Axxon PSIM section);
Advanced setting of video signal processing by Server (see The Settings panel of the Video subsystem 
section);
Advanced setting of distributed architecture (see Extended setup of the distributed architecture);
Changing network names and IP-addresses in the configuration database (see Changing computer names 
and IP addresses in the Axxon PSIM configuration database);
Limiting the RAM used by MS SQL server (see Limiting memory usage by an MS SQL server);
Advanced setting of audio or video recording to an archive (see The Settings panel of the Video subsystem 
section);
Re-indexing audio and video archives (see Re-indexing the audio and video recordings archive);
Selecting the analog video output operation mode The Settings panel of the Video subsystem section);
Testing the operability of video capture cards (see Testing video capture cards);
Advanced setting of PTZ devices (see The Settings panel of the PTZ section);
Advanced setting of POS PSIM (see The Settings panel of the POS PSIM section);
Displaying versions of Axxon PSIM modules (see The Settings panel of the Version section).

4.2 Starting and shutting-down the Tweaki.exe utility
To start the tweaki.exe utility, do one of the following:

Start the utility from the Windows taskbar. Click Start => All Programs => Axxon PSIM => Tools => 
Advanced settings utility. The tweaki.exe utility is available from the Start menu with the following 
installation types of Axxon PSIM: Server, Remote administrator workstation, Remote client.
Start the utility from the Tools folder of the Axxon PSIM program folder: C:\Axxon PSIM\Tools\Tweaki.exe.

The Axxon PSIM Advanced Setup dialog box appears after running the tweaki.exe utility.

Attention!

Invalid values of the registry keys may lead to the system failure.
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To shutdown the tweaki.exe utility and save the changes click OK. To shutdown the tweaki.exe utility without 
saving the changes, click  .

4.3 Interface of the Tweaki.exe utility
The user interface of the tweaki.exe utility consists of two interrelated elements:

Tree of sections (1).
Settings panel for each section (2).
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Sections tree of the tweaki.exe dialog box has static structure and is used for navigation in the utility. To access the 
settings panel for the required section, left-click the corresponding tree tab.

4.3.1 The Settings panel of the Windows section
The Windows section is used to set Windows running Windows OS. The settings panel for the Windows section is 
shown in the figure.
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The parameters of the Windows setting panel are described in the table.

N
o

Parameter 
name

Field type Description Represen
tation

Default 
value

Value range

The Shell group

1 The Explorer/
File switch

Set in the 
position

Selection of Windows 
working shell

Attention! Disable UAC 
to run the Axxon PSIM 
software package as 
the shell. Configuration 
of the local security 
policy is required for 
full disabling of UAC in 
the Windows 8 and 
Windows 8.1 OS – see 
OS settings for correct 
operation of Remote 
Admin Workstation or 
Server

- Explorer Explorer – Microsoft 
Explorer is loaded as 
working Windows 
OS shell 
(corresponds to 
standard Windows 
OS settings).

File – Axxon PSIM
starts as a working 
shell of Windows OS

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314509894/OS+settings+for+correct+operation+of+Remote+Admin+Workstation+or+Server
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N
o

Parameter 
name

Field type Description Represen
tation

Default 
value

Value range

2 The File field 

with 
button. Active 
for the File
switch 
position

Button is 
pressed

Opens standard 
Windows window 
«Open» to select shell 
file of OS Windows. 
Full path to the file is 
displayed in the field

- - The psim.exe or 
psim_host.exe 
executive file is 
selected as a shell

The Autologon group

3 The Enable
checkbox

Checkbox Activates automatic 
log on of the user to 
OS Windows

Boolean 
type

No Yes – automatic log 
on of the user is 
activated

No – automatic log 
on of the user is not 
activated

4 The 
Username
field

Type-in the 
value

Set the username for 
logging on the OS 
Windows

- - Up to 64 characters. 
Depends on the 
settings of Windows 
user account (stored 
locally or on domain 
server)

5 The Password
field

Type-in the 
value

Set the password for 
logging on the OS 
Windows

- - 8 to 14 characters

Depends on the 
settings of Window’s 
user account (stored 
locally or on domain 
server)

6 The Domain
field

Automatical
ly

Displays the name of 
domain server (if there 
is any), where data  
concerning user 
account is stored (user 
name and password)

- - Depends on domain 
net settings (net 
settings of OS 
Windows 
correspondingly)
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N
o

Parameter 
name

Field type Description Represen
tation

Default 
value

Value range

7 Restart Axxon 
PSIM on user 
login
checkbox

Setting 
checkbox

Specifies the way of 
restart the Axxon PSIM
software installed as a 
service on user login

Boolean 
type

Yes Yes – the Axxon PSIM
software installed as 
a service restarts 
under the current 
user if it belongs to 
the PSIM Users 
group

No – The Axxon PSIM
software installed as 
a service doesn't 
restart under the 
current user even for 
users belonging to 
the PSIM Users 
group

4.3.2 The Settings panel of the Axxon PSIM section
The Axxon PSIM section is used for Axxon PSIM advanced setup. The settings panel for the Axxon PSIM section is 
shown in the figure.
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The parameters of the Axxon PSIM settings panel are described in the table.

N
o

Paramete
r name

Method 
of 
setting 
the 
paramet
er value

Description Repres
entatio
n

Defa
ult 
valu
e

Value range

1 The Core 
IP address
field with 

button. 
Set on the 
Client

Enter the 
value in 
the field/
use the 

 butt
on

Sets the IP address of the Axxon PSIM
server to which the psim_host.exe 
module is connected by default. 

In case of pressing  button, IP 
address of the local computer is set

IP 
address

127.0
.0.1

Depends on net 
settings of the 
Server. In case of 
connection 
failure dialog 
window requiring 
IP address is 
displayed
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N
o

Paramete
r name

Method 
of 
setting 
the 
paramet
er value

Description Repres
entatio
n

Defa
ult 
valu
e

Value range

2 Keyboard 
prefix 

Enter the 
value in 
the field

Sets the prefix for a special keyboard. 
When a button is pressed on this key-
board the Axxon PSIM detects when the 
button was pressed on this very 
keyboard

Symbol — Usually, a tilde 
(~), code 126

The Logging subsystem group
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N
o

Paramete
r name

Method 
of 
setting 
the 
paramet
er value

Description Repres
entatio
n

Defa
ult 
valu
e

Value range

3 Debug 
mode 

Select 
the value 
from the 
drop-
down list

Sets the mode of the Axxon PSIM Debug 
window displaying (see The Debug 
window)

List of 
availabl
e 
modes 
of 
Debug 
windo
w
displayi
ng

Starti
ng 
with 
week
ly 
build 
1.0.1.
172, 
the 
Debu
g 4 
mod
e is 
enabl
ed by 
defau
lt. 
Befor
e this 
build
—
Disa
bled
is a 
defau
lt 
mod
e

Disabled—Debug 
window is not 
displayed

Debug 1—Debug 
window is 
displayed  and a 
log file containing 
recordings about 
modules errors is 
created

Debug 2—Debug 
window is 
displayed and a 
log file containing 
recordings about 
modules errors 
and alerts is 
created

Debug 3—Debug 
window is 
displayed and a 
log file containing 
recordings about 
all the modules 
events is created

Debug 4—Debug 
window is 
displayed and a 
log file containing 
recordings about 
all the modules 
events, and also 
additional menu 
that is individual 
for each module 
(used by 
programmers) are 
created

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314512084/The+Debug+window
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N
o

Paramete
r name

Method 
of 
setting 
the 
paramet
er value

Description Repres
entatio
n

Defa
ult 
valu
e

Value range

4 Log-
storing 
time 
(hours)

Enter the 
value in 
the field

Sets the time of keeping log files Sequen
ce

48 
hours

> 0

5 Counters 
logging 
time (sec)

Enter the 
value in 
the field

Assigns the time interval in seconds for 
logging processor load, memory usage, 
and disk usage

Sequen
ce

60 Positive whole 
numbers not less 
than 60 and zero. 
If the value 0 is 
specified, sensor 
data is not 
included in the 
log file

6 Save logs Set the 
checkbo
x

Enables logs saving Boolea
n type

Yes Yes—logs are 
saved

No—logs are not 
saved

7 Redirect 
to 
debugger

Set the 
checkbo
x

Enables the debugger Boolea
n type

None Yes—the 
debugger is in use

No—the 
debugger is not in 
use

8 Maximum 
size (MB)

Enter the 
value in 
the field

Defines the maximum size of RAM that 
log files can use. Log files are archived 
after that size is reached

Sequen
ce

100 
MB

>= 100

Values less than 
100 Mb are 
ignored

The JPG and AVI files export path group
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N
o

Paramete
r name

Method 
of 
setting 
the 
paramet
er value

Description Repres
entatio
n

Defa
ult 
valu
e

Value range

9 The 
Default 
(Axxon 
PSIM\Exp
ort)/Other
switch

Set in the 
position

Sets the folder for exported frames 
from Axxon PSIM video archive (see 
Frame export)

— Defa
ult 
(Axxo
n 
PSIM
\Exp
ort)

Default (Axxon 
PSIM\Export)—
exported to the C:
\Users\%current 
user name%
\Documents\Axxo
n PSIM\export\ 
folder

Other—exported 
to the selected 
folder

1
0

The Other
field with 

the 
button

Click the 
button/
enter the 
value in 
the field

Sets the path name to the folder, where 
frames from video archive are to be 
exported when the switch is set in the 
Other position.

Note. The specified path will be applied 
to the ExportDir registry key located in 
HKLM\SOFTWARE\WOW6432Node\Axxon
Soft\AxxonPSIM\Video (see Registry keys 
reference guide)

Path 
name

— —

1
1

Open 
folder

Click the 
button

Opens the current folder for frame 
export

— — —

1
2

Record 
path

Set the 
checkbo
x

The checkbox allows you to prohibit 
changing the export directory when 
exporting an archive period

Boolea
n type

No Yes—export 
catalogue change 
is forbidden

No—export 
catalogue change 
is allowed

No group

Note

The selected value is written 
to the ExportDirFixed registry 
key located in 
HKLM\SOFTWARE\WOW6432N
ode\AxxonSoft\AxxonPSIM\Vi
deo (see Registry keys 
reference guide).

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314509003/Frame+export
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314513094/Registry+keys+reference+guide
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314513094/Registry+keys+reference+guide
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N
o

Paramete
r name

Method 
of 
setting 
the 
paramet
er value

Description Repres
entatio
n

Defa
ult 
valu
e

Value range

1
3

Receive 
uncompre
ssed 
video

Set the 
checkbo
x

Enables receiving uncompressed video 
from the Server. As a rule is set on the 
Client

Boolea
n type

No Yes—Client 
receives 
uncompressed 
video from the 
Server

No—Client 
receives 
compressed 
video from the 
Server

1
4

Event 
viewer 
over all 
windows

Set the 
checkbo
x

Enables displaying the Event viewer 
window over all windows

Boolea
n type

No Yes—the Event 
viewer window is 
displayed over all 
windows

No—the Event 
viewer  window is 
displayed if a 
corresponding 
screen is selected

1
5

Only local 
protocol

Set the 
checkbo
x

Enables logging the events registered 
in the given computer to the Events 
protocol database.

Note. This parameter can be set on the 
settings panel of the Computer object—
see Configuring events logging

Boolea
n type

No Yes—events 
registered in the 
given computer 
are recorded to 
the Events 
protocol 
database

No—all required 
events are 
recorded to the 
Events protocol 
database

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314510200/Configuring+events+logging
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N
o

Paramete
r name

Method 
of 
setting 
the 
paramet
er value

Description Repres
entatio
n

Defa
ult 
valu
e

Value range

1
6

Sort tree 
objects by 
ID

Set the 
checkbo
x

Enables sorting of objects in the tree by 
identifier.

Note 1. If sorting by name is chosen, and 
there are numbers in the object name, 
then the objects will be sorted in 
alphabetical order. For example, an 
object with the name "115" will be 
above the object with the name "15", 
because in the name "115" the second 
number is 1, and in the name "15" the 
second number is 5.

Note 2. This key also affects the sorting 
of objects in the tree when adding the 
objects to a layer in the Map Editor 
utility

Boolea
n type

No Yes—objects in 
the tree are 
sorted by 
identifier

No—objects in 
the tree are 
sorted by name

1
7

Disable 
protocol

Set the 
checkbo
x

Disables events logging to the Event 
viewer database on this computer.

Note. This parameter can be set on the 
settings panel of the Computer object—
see Configuring events logging

Boolea
n type

No Yes—events are 
not logged to the 
Event viewer 
database

No—events are 
logged to the 
Event viewer 
database

1
8

Used 
memory 
dump

Set the 
checkbo
x

Enables logging .dmp file with a copy of 
main memory with incorrect shutting 
down at least one of the system 
modules to the Axxon PSIM root folder

Boolea
n type

No Yes—memory 
dump is created

No—memory 
dump is not 
created

1
9

Support 
old scripts

Set the 
checkbo
x

Enables the support of program tools in 
Axxon PSIM

Boolea
n type

No Yes—both scripts 
and programs are 
supported

No—only scripts 
are supported

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314510200/Configuring+events+logging
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N
o

Paramete
r name

Method 
of 
setting 
the 
paramet
er value

Description Repres
entatio
n

Defa
ult 
valu
e

Value range

2
0

Time 
synchroni
zation

Set the 
checkbo
x

Sets time synchronization of all 
computers in the distributed system 
with system time of this computer. 
Time is automatically synchronized at 
midnight every 24 hours or when Axxon 
PSIM is started on the Server that is the 
source of time synchronization

Boolea
n type

No Yes—
synchronization is 
enabled

No—
synchronization is 
disabled

2
1

Overlay in 
Event 
protocol

Select 
the value 
from the 
drop-
down list

Sets the overlay mode for processing 
the video signals that can be viewed 
with the help of the Event protocol 
object

Names 
of 
overlay 
modes

Overl
ay 2

None—video 
signals are not 
processed by 
video card

Overlay 1—
Direct3D is used

Overlay 2—
DirectDraw is 
used

2
2

Applicatio
n 
language

Select 
the value 
from the 
drop-
down list

Assigns the Axxon PSIM interface 
language

Names 
of 
installe
d 
languag
es

— Depends on the 
set of installed 
languages. 
See Axxon PSIM 
Software 
System's 
interface 
language

The settings panel of the Connection section
The Connection section is used for setting up automatic connections between the client and backup video servers 
in case of connection loss with the main server. In the Connection section, you must specify the network names 
and IP addresses of the backup video servers, as they aren't listed in the Windows registry by default.

The settings panel of the Connection section is shown in the figure.

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314510595/Axxon+PSIM+Software+System+s+interface+language
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The table describes the setting parameters of the Connection section.
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№ Parameter 
name

Method for 
setting the 
parameter 
value

Parameter description Representatio
n

Default 
value

Value range

1 Allow unsafe 
transport 
checkbox

Set the 
checkbox

Enables the access to 
the use of an unsecured 
port (HTTP port)

Boolean type Clear Set—Operator 
can allow the 
use of an 
unsecured port

Clear—the use 
of an unsecured 
port is 
prohibited

2 HTTP port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
unsecured port that will 
be used for data 
transmission

Note. The field is inactive 
if the Allow unsafe 
transport checkbox isn't 
set

Positive 
integers

22080 NA

3 HTTPS port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
secured port that will be 
used for data 
transmission

Positive 
integers

22433 NA

4 Connection 
timeout 
(sec) field 

Enter the 
value in the 
field

Sets the time in seconds 
after which the client 
automatically connects 
to the backup video 
servers in case of 
connection loss with the 
main server

Seconds 10 From 0 to 
999999999

5 System 
identifier 
field 

Enter the 
value in the 
field

Sets the network name 
of the backup video 
server if the connection 
with the main server is 
lost

NA NA Depends on the 
network 
settings of the 
backup video 
server
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№ Parameter 
name

Method for 
setting the 
parameter 
value

Parameter description Representatio
n

Default 
value

Value range

1 Allow unsafe 
transport 
checkbox

Set the 
checkbox

Enables the access to 
the use of an unsecured 
port (HTTP port)

Boolean type Clear Set—Operator 
can allow the 
use of an 
unsecured port

Clear—the use 
of an unsecured 
port is 
prohibited

2 HTTP port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
unsecured port that will 
be used for data 
transmission

Note. The field is inactive 
if the Allow unsafe 
transport checkbox isn't 
set

Positive 
integers

22080 NA

3 HTTPS port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
secured port that will be 
used for data 
transmission

Positive 
integers

22433 NA

4 Connection 
timeout 
(sec) field 

Enter the 
value in the 
field

Sets the time in seconds 
after which the client 
automatically connects 
to the backup video 
servers in case of 
connection loss with the 
main server

Seconds 10 From 0 to 
999999999

6 IP address 
field 

Enter the 
value in the 
field

Sets the IP address of 
the selected backup 
video server

IP address NA Depends on the 
network 
settings of the 
backup video 
server
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№ Parameter 
name

Method for 
setting the 
parameter 
value

Parameter description Representatio
n

Default 
value

Value range

1 Allow unsafe 
transport 
checkbox

Set the 
checkbox

Enables the access to 
the use of an unsecured 
port (HTTP port)

Boolean type Clear Set—Operator 
can allow the 
use of an 
unsecured port

Clear—the use 
of an unsecured 
port is 
prohibited

2 HTTP port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
unsecured port that will 
be used for data 
transmission

Note. The field is inactive 
if the Allow unsafe 
transport checkbox isn't 
set

Positive 
integers

22080 NA

3 HTTPS port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
secured port that will be 
used for data 
transmission

Positive 
integers

22433 NA

4 Connection 
timeout 
(sec) field 

Enter the 
value in the 
field

Sets the time in seconds 
after which the client 
automatically connects 
to the backup video 
servers in case of 
connection loss with the 
main server

Seconds 10 From 0 to 
999999999
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№ Parameter 
name

Method for 
setting the 
parameter 
value

Parameter description Representatio
n

Default 
value

Value range

1 Allow unsafe 
transport 
checkbox

Set the 
checkbox

Enables the access to 
the use of an unsecured 
port (HTTP port)

Boolean type Clear Set—Operator 
can allow the 
use of an 
unsecured port

Clear—the use 
of an unsecured 
port is 
prohibited

2 HTTP port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
unsecured port that will 
be used for data 
transmission

Note. The field is inactive 
if the Allow unsafe 
transport checkbox isn't 
set

Positive 
integers

22080 NA

3 HTTPS port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
secured port that will be 
used for data 
transmission

Positive 
integers

22433 NA

4 Connection 
timeout 
(sec) field 

Enter the 
value in the 
field

Sets the time in seconds 
after which the client 
automatically connects 
to the backup video 
servers in case of 
connection loss with the 
main server

Seconds 10 From 0 to 
999999999

7 Enable 
server 
selection 
menu 
checkbox

Set the 
checkbox

Enables the server 
selection menu.

Boolean type Clear Set—Operator 
can enable the 
server selection 
menu
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№ Parameter 
name

Method for 
setting the 
parameter 
value

Parameter description Representatio
n

Default 
value

Value range

1 Allow unsafe 
transport 
checkbox

Set the 
checkbox

Enables the access to 
the use of an unsecured 
port (HTTP port)

Boolean type Clear Set—Operator 
can allow the 
use of an 
unsecured port

Clear—the use 
of an unsecured 
port is 
prohibited

2 HTTP port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
unsecured port that will 
be used for data 
transmission

Note. The field is inactive 
if the Allow unsafe 
transport checkbox isn't 
set

Positive 
integers

22080 NA

3 HTTPS port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
secured port that will be 
used for data 
transmission

Positive 
integers

22433 NA

4 Connection 
timeout 
(sec) field 

Enter the 
value in the 
field

Sets the time in seconds 
after which the client 
automatically connects 
to the backup video 
servers in case of 
connection loss with the 
main server

Seconds 10 From 0 to 
999999999

Note. You can connect 
several servers at once

Clear—
Operator 
cannot enable 
the server 
selection menu
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№ Parameter 
name

Method for 
setting the 
parameter 
value

Parameter description Representatio
n

Default 
value

Value range

1 Allow unsafe 
transport 
checkbox

Set the 
checkbox

Enables the access to 
the use of an unsecured 
port (HTTP port)

Boolean type Clear Set—Operator 
can allow the 
use of an 
unsecured port

Clear—the use 
of an unsecured 
port is 
prohibited

2 HTTP port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
unsecured port that will 
be used for data 
transmission

Note. The field is inactive 
if the Allow unsafe 
transport checkbox isn't 
set

Positive 
integers

22080 NA

3 HTTPS port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
secured port that will be 
used for data 
transmission

Positive 
integers

22433 NA

4 Connection 
timeout 
(sec) field 

Enter the 
value in the 
field

Sets the time in seconds 
after which the client 
automatically connects 
to the backup video 
servers in case of 
connection loss with the 
main server

Seconds 10 From 0 to 
999999999
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№ Parameter 
name

Method for 
setting the 
parameter 
value

Parameter description Representatio
n

Default 
value

Value range

1 Allow unsafe 
transport 
checkbox

Set the 
checkbox

Enables the access to 
the use of an unsecured 
port (HTTP port)

Boolean type Clear Set—Operator 
can allow the 
use of an 
unsecured port

Clear—the use 
of an unsecured 
port is 
prohibited

2 HTTP port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
unsecured port that will 
be used for data 
transmission

Note. The field is inactive 
if the Allow unsafe 
transport checkbox isn't 
set

Positive 
integers

22080 NA

3 HTTPS port 
field

Enter the 
value in the 
field.

Note. The 
value is 
entered 
using the 
keyboard, or 
by using the 
up and down 
arrows

Sets the number of the 
secured port that will be 
used for data 
transmission

Positive 
integers

22433 NA

4 Connection 
timeout 
(sec) field 

Enter the 
value in the 
field

Sets the time in seconds 
after which the client 
automatically connects 
to the backup video 
servers in case of 
connection loss with the 
main server

Seconds 10 From 0 to 
999999999

8 Allow all 
names 
button

Click the 
button

Adds automatically the 
computers' IP addresses, 
set in the System 
identifier column, to the 
IP address column if 
these IP addresses are 
enabled and identified

NA NA NA
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The Settings panel of the Visitor management system section
The Visitor management system section is designed for creating common photo database of the Access 
Manager module (is not included into Axxon PSIM base configuration, see Creating a single photograph database). 
In this section it is necessary to specify netnames of computer where the photos are to be stored. Photos are to be 
stored in the Person folder (<Axxon PSIM>\Bmp\Person).

The Settings panel of the Distributed configuration section
The Distributed configuration section is for Axxon PSIM common database adjustment when real computer 
netnames do not coincide with the names in the database (for instance when the computer with the database is 
replaced). The section is also used for adjusting IP-address of selected computer in the database.

The settings panel for the Distributed configuration section is shown in the figure.

Note

To delete a specified server, select it in the list (click the row) and press Ctrl+Del on the keyboard.

Note.

The Person folder is automatically created when the Access Manager module is installed.

https://docs.axxonsoft.com/confluence/spaces/acfaPSIM100en/pages/235453788/Creating+a+single+photograph+database
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The parameters of the settings panel are described in the table.

№ Parameter 
name

Field type Description Representatio
n

Default 
value

Value range

1 The Select 
database
button

Click the button Opens the 
standard Data 
Link Properties
dialog box to 
choose the 
database, where 
netname and/or 
IP-address are to 
be changed.

- - -

2 The Use 
current DB
button

Click the button Selection of 
main Axxon PSIM
database 
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№ Parameter 
name

Field type Description Representatio
n

Default 
value

Value range

3 The 
Available 
systems
table

Automatically Displays the list 
of netnames of 
computers that 
are in selected 
database

- - Netnames of 
computers 
connections 
between which are 
set on the 
Architecture tab

4 The New 
system ID 
field with 

 button

Button is clicked 
and value is 
selected from 
the list/ typed in 
the field.

Specifies a new 
netname of a 
computer 
selected in the 
Available 
systems table

- - Depends on the 
current net 
settings of the 
required 
computer.

If the network 
name is longer 
than 15 
characters, then 
first 15 characters 
are to be specified 
as the network 
name in this field

5 The Update 
protocol
checkbox

Checkbox Replaces the 
computer’s 
netname in the 
Events protocol
table of the 
selected main 
Axxon PSIM 
database

Boolean type None Yes – computer’s 
netname is 
replaced in the 
Events protocol
table

No – computer’s 
netname is not 
replaced in the 
Events protocol
table

6 The Clear 
protocol
checkbox

Checkbox Clears the event 
log from the 
Events protocol
table of the 
selected main 
Axxon PSIM
database

Boolean type None No – the list of 
registered events 
is not cleared

Checked – the list 
of registered 
events is cleared
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№ Parameter 
name

Field type Description Representatio
n

Default 
value

Value range

7 The Update 
DB button

Click the button Runs  the 
process of 
updating the 
selected 
database in 
accordance with 
given settings

- - -

8 The Update 
protocol
field

Automatically Displays 
updating process 
of the selected 
database

- - Depends on the 
structure of the 
selected database 
and the given 
settings

The Change IP address group

9 The 
dropdown 
list with IP-
addresses

Select from the 
list

Specifies IP-
address that is to 
be changed  in 
the selected 
database

IP-addresses of 
 computers in 
the selected 
database

- Depends on the 
number of 
computers 
connections 
between which are 
set on the 
Architecture tab

10 Field of 
setting IP-
address

Type-in the 
value in the field

Specifies a new 
IP-address to be 
changed in the 
selected 
database

IP-address 127.0.0.1 Depends on the 
current net 
settings of the 
required computer

11 The Edit 
button

Click the button Changes the IP-
address of the 
required 
computer in the 
selected 
database

- - -

The Settings panel of the MSDE (MS SQL) configuration section
The MSDE (MS SQL) configuration section is designed for setting the limits of RAM space for MS SQL Server 
operation with databases of SQL format. This limitation enhances the performance of the system.

The settings panel for the MSDE (MS SQL) configuration section is shown in the figure.
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The parameters of the settings panel are described in the table.

№ Parameter 
name

Field type Description Representation Default 
value

Value range

1 The Select 
database
button

Click the 
button

Opens the standard 
Data Link 
Properties dialog 
box for choosing 
the database of MS 
SQL format the 
RAM space for 
which is to be 
limited.

- - -

2 The Use 
current DB
button

Click the 
button

Selects the main 
Axxon PSIM 
database

- - -

3 The 
Maximum 
memory 
usage (MB)
indicator

Enter the 
value in the 
field

Sets the space of 
RAM in MB for SQL 
Server operation

MB 4096 Depends on full 
space of RAM.
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№ Parameter 
name

Field type Description Representation Default 
value

Value range

4 The SQL 
database 
size field

Automaticall
y

Displays the 
current size of all 
MS SQL databases 
on the Server

Positive real 
number with 
amount 
precision − two 
decimals

- Depends on the 
capacity 
of storage 
where the 
database is.

4.3.3 The Settings panel of the Video subsystem section
The Video subsystem section is used for advanced configuration of the video subsystem in order to enhance the 
performance of Axxon PSIM.

The settings panel for the Video subsystem section is shown in the figure.

The parameters of the settings panel are described in the table.
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N
o

Parameter 
name

Method of 
setting the 
parameter 
value

Parameter 
description

Represent
ation

Default 
value

Value range

1 Ring Enter the value 
in the field

Sets free disk space; 
when the limit is 
reached, the earliest 
recordings will be 
deleted on loop (see 
General information 
on video archiving). 
If two or more disks 
are used for video 
archiving, archiving 
on current disk is 
performed till there 
is FreeMbCritical of 
free disk space 
(1000 MB by default, 
see the info on the 
key in Registry keys 
reference guide).

Free space set by 
the Ring parameter 
is used for recording 
temporary files. This 
means that when 
the limit set by the 
Ring parameter is 
reached, the 
maximum size of the 
temporary file is 
Ring (registry key 
FreeMb). Video can 
contain less frames 
than set by the 
Frame count
parameter.

Note. Old recordings 
may get deleted 
before the remaining 
disk space reaches 
the specified value if 
the disk space is less 
than 15000

MB 5000 Depends on the hard 
disk space

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314509977/General+information+on+video+archiving
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314513094/Registry+keys+reference+guide
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N
o

Parameter 
name

Method of 
setting the 
parameter 
value

Parameter 
description

Represent
ation

Default 
value

Value range

2 Frame count Enter the value 
in the field

Sets the maximum 
number of frames in 
one recording file

Frame 1500 1500 to 10000. We 
don't recommend 
changing the default 
value

3 Recording 
time

Enter the value 
in the field/
select the value 
from the list

Sets the length of 
the file in seconds, 
restricting 
fragment’s size not 
by number of 
frames, but by time 
of its recording

Time in 
seconds

0 Unlimited

4 Restart 
recording on 
entering the 
archive

Enter the value 
in the field/
select the value 
from the list

Enables the restart 
of recording on 
entering the archive

Integer No 0—video fragment
that was being 
recorded at the 
moment of entering 
the archive is forcibly 
stopped, and a new 
one starts. As a 
result, the user who 
enters the archive 
sees a freeze frame 
corresponding to the 
moment of entry

>0—the recording is 
restarted when 
entering the archive, 
while positioning in 
the archive is carried 
out with a shift back 
to the specified value 
in seconds

-1—recording is not 
stopped at the 
moment of entering 
the archive
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N
o

Parameter 
name

Method of 
setting the 
parameter 
value

Parameter 
description

Represent
ation

Default 
value

Value range

5 Rebuild 
index

Click the 
button

Deletes the file that 
stores indexes. After 
deleting the file, 
click the Rebuild 
index button to 
restart Axxon 
PSIM and create a 
new file with 
updated indexes

- - -

6 Priority Select the 
value from the 
drop-down list

Sets the execution 
priority of all Axxon 
PSIM processes

Names of 
priority 
processes

Below 
normal

Realtime, High, 
Above normal, 
Normal, Below 
normal, Low

7 Analog 
video 
output

Select the 
value from the 
drop-down list

Selects the 
operation mode of 
the analog output

Names of 
available 
modes

All All—video signal 
from a camera is 
displayed on a 
separate analog 
monitor

One—video signals 
from cameras that 
are connected to 
different video 
capture devices, are 
displayed on a 
separate analog 
monitor



PSIM 2.0 (english) – Additional utilities for the Axxon PSIM software

Tweaki.exe utility for advanced setup of the Axxon PSIM software system– 68

N
o

Parameter 
name

Method of 
setting the 
parameter 
value

Parameter 
description

Represent
ation

Default 
value

Value range

8 Use virtual 
grabber

Set the 
checkbox

Allows access to 
virtual Video 
capture devices
settings in Axxon 
PSIM.

Note. Desktop 
Experience Feature
must be enabled 
when using a virtual 
video capture device 
on server OS and avi 
files

 

Boolean 
type

Clear Set—the Virtual and 
Virtual bench values 
are available from 
the Type drop-down 
list on the settings 
panel of the Video 
capture device
objects

Clear—the Virtual
and Virtual bench 
values aren't 
available for the 
Video capture 
device objects

9 Hide mask Set the 
checkbox

Disables displaying 
the video hidden by 
the motion 
detection mask. 
Video area marked 
by motion detection 
mask will be hidden 
by a grey fill. This 
feature works only 
on uncompressed 
video from FS or FX 
local video capture 
cards

Boolean 
type

Clear Clear—video hidden 
by the mask is 
displayed

Set—video hidden by 
the mask video isn't 
displayed

1
0

Automatic 
font size 
selection for 
export

Set the 
checkbox

Enables the relative 
font size for 
captions (camera 
No. and time) when 
exporting a frame or 
fragments of the 
video archive

Boolean 
type

Clear Clear—when 
exporting a frame, 
regardless of the 
video resolution, the 
caption size remains 
constant as set by the 
SubtitlesFontSize 
registry key, see the 
Registry keys 
reference guide

Set—when exporting 
a frame, the caption 
size is scaled 
depending on the 
video resolution

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314513094/Registry+keys+reference+guide
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N
o

Parameter 
name

Method of 
setting the 
parameter 
value

Parameter 
description

Represent
ation

Default 
value

Value range

1
1

Gradual 
increment 
of camera 
tile

Set the 
checkbox

Enables a gradual 
increase of the 
Surveillance 
window on the 
custom layout by 
double-clicking the 
left mouse button. 
All Surveillance 
windows on the 
layout must be of 
the same size to 
ensure proper 
operation of the key

Boolean 
type

Clear Clear—Surveillance 
window is expanded 
to the entire Video 
surveillance monitor 
by double-clicking 
the left mouse button

Set—by double-
clicking the left 
mouse button, the 
Surveillance window 
is expanded 
gradually: the first 
double-click expands 
it two times of the 
initial size, the 
second double-click 
expands it three 
times of the initial 
size, and so on. The 
Surveillance windows 
adjacent to it are 
hidden on the layout

1
2

Swap frame 
fields

Set the 
checkbox

Switches Axxon PSIM
from basic to 
additional driver if 
there are video 
artifacts when using 
the basic driver

Boolean 
type

Clear Clear—Axxon PSIM
operates with basic 
driver

Set—Axxon PSIM
operates with 
additional driver

1
3

Use 
PureVideo/
CUDA 
hardware 
acceleration

Set the 
checkbox

Enables PureVideo/
CUDA support on 
the Server when 
decompressing 
video from IP 
devices if PureVideo 
HD card of the 
second or third 
generation (NVIDIA 
VP2 and VP3) is 
installed. Used to 
reduce CPU load 
due to resources of 
graphics processor

Boolean 
type

Set Clear—PureVideo/
CUDA isn't used

Set—PureVideo/
CUDA is used
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N
o

Parameter 
name

Method of 
setting the 
parameter 
value

Parameter 
description

Represent
ation

Default 
value

Value range

1
4

Pause 
playback at 
archive 
entry

Set the 
checkbox

The Pause button is 
clicked when 
entering the archive

Boolean 
type

Clear Set—the Pause
button is clicked 
when entering the 
archive, you can 
navigate through the 
archive using arrow 
keys

Clear—the Pause
button isn't clicked 
when entering the 
archive

1
5

Step of 
digital zoom 
scale

Enter the value 
in the field/
select the value 
from the list

Specifies the 
fractional step of 
video image 
zooming

Numbers 
with the 
fixed point

2.00 Maximum value 
depends on the 
maximum scale of 
digital zoom (see 17).

Minimum value is 
1.00

1
6

Maximum 
ratio of 
digital zoom

Enter the value 
in the field/
select the value 
from the list

Specifies the 
maximum value of 
digital zoom of 
video image

Numbers 16 1–16

1
7

Cameras 
without 
video 
compressio
n 

Enter the value 
in the field

Specifies the 
numbers of cameras 
connected to the 
video capture cards 
with compression. 
There is no 
compression for 
these cameras, i.e. 
the compressor 
settings in Axxon 
PSIM are ignored

Camera 
serial 
number

- Depends on the 
number of cameras 
registered in the 
system

 

Note

 Setting the non-zero value to the Recording time parameter does not disable the Frame count
parameter. If the values for both parameters are set, then the file recording will be performed in 
accordance with the value which comes first. For instance, if the value of Recording time is equal to 10 
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4.3.4 The Settings panel of the Testing video capture cards section
The Testing video capture cards section is designed to test the connection of the cameras to the video capture 
card.

The settings panel for the Testing video capture cards section is shown in the figure.

 

The parameters of the settings panel are described in the table.

seconds and Frame count is equal to 500 frames (by default) and in 10 seconds the fragment consists of 80 
frames, then 80-frame file will be recorded. 

Note

To use this functionality, Axxon PSIM must be shut down. If it is running, the message "Cards not found" 
will be displayed.
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1.

N
o

Para
mete
r 
nam
e

Field 
type

Description Represent
ation

Defaul
t 
value

Value range

1 Boar
d

Drop-
down list

Specifies the video capture card 
which camera connections are to be 
checked

List of 
video 
capture 
cards

N/A Depends on the 
number of installed 
video capture cards

2 Te
st

Button Starts the testing process of the 
video capture card. The Axxon PSIM
system is to be closed at the time of 
testing.

N/A N/A N/A

The Channels state table

3 Chan
nel

Column 
(set 
automat
ically)

Displays the channels numbers of the 
selected video capture card

N/A N/A From 1 to 16

4 State Column 
(set 
automat
ically)

Displays the state of camera 
connections to the channels of the 
selected video capture cards

N/A N/A Attach—the camera 
is attached

Detach—the camera 
is detached

If the video capture card is not recognized by the tweaki.exe utility, we recommend you to check whether the 
camera access is allowed for applications. To do this:

Go to Windows Settings→ Privacy→ Camera.
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2. Allow apps to access your camera by setting the switch to the On position as shown in the figure below.

4.3.5 The Settings panel of the PTZ section
The PTZ section is used for setting the telemetry control elements.

The settings panel for the PTZ  section is shown in the figure.
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The parameters of the PTZ  settings panel are described in the table.

N
o

Parameter 
name

Field type Description Representati
on

Default 
value

Value range

1 The Delay 
between 
commands 
(ms) field

Type-in the 
value

Sets  the delay time 
between executing the 
commands for PTZ 
devices

This parameter is not 
supported by IP 
cameras.

ms 250 No limitations. It 
is not 
recommended to 
change the 
default value.

2 The Delay by 
priority (ms)
field

Type-in the 
value

Sets the delay time 
before switch from the 
PTZ control to a user 
with lower or equal 
priority.

ms 30000 No limitations. It 
is not 
recommended to 
change the 
default value.

The Joystick group
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N
o

Parameter 
name

Field type Description Representati
on

Default 
value

Value range

3 The
Sensitivity 
 (1-10) field

Enter the 
value in the 
field

Sets sensitivity of the 
joystick: the less value 
the more sensitivity. If 
value of parameter is 
small then camera will 
react on even small 
deviations of the 
joystick. If value of 
parameter is great the 
camera will stay fixed 
until significant 
deviation  of joystick

Sensitivity in 
conditional 
units

5 1-10

4.3.6 The Settings panel of the POS PSIM section
The POS section is designed for setting the POS PSIM module for controlling cashier operations (is not included in 
Axxon PSIM basic version). Detailed information about POS PSIM configuring using the tweaki.exe utility is presented 
in The settings panel for the POS sections using the tweaki.exe utility section in the Administrator's Guide 
documentation for POS PSIM software package.

https://docs.axxonsoft.com/confluence/spaces/posPSIM100en/pages/235448246/The+settings+panel+for+the+POS+sections+using+the+tweaki.exe+utility
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4.3.7 The Settings panel of the Version section
The Version section provides information about Axxon PSIM software modules: versions, paths to executable files 
and .dll libraries, file sizes and dates of creation and modification.

The settings panel for the Version section is shown in the figure.

4.4 Typical tasks concerning system extended settings

4.4.1 Enabling and configuring the debug mode of Axxon PSIM

•
•

On the page:

Enabling debug mode
Configuring log file parameters

Debug mode is a special operation mode when the Debug window is open, and is designed for analyzing the 
progress of Axxon PSIM software operation and for prompt debugging in case errors occur. Log files are created in 
this mode—they are stored on the disk for a specific time period. 
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1.
2.
3.
4.

5.
6.

7.

Enabling debug mode
Starting with weekly build 1.0.1.172, the Debug 4 mode is enabled by default. In previous versions, the Debug 
mode is disabled by default. To enable the Debug mode, do the following::

Shut down Axxon PSIM.
Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility)
Select the Axxon PSIM node in the tree on the left side of the utility dialog box.
Change the parameter Debug mode from Disabled to Debug 1, Debug 2, Debug 3 or Debug 4 (see 
description of modes in The Settings panel of the Axxon PSIM section).
Click the OK button.
Start Axxon PSIM.
The Debug window item will appear in the Axxon PSIM main control menu.

Select Debug window in the main control menu to open the Debug window. The selected item will be 
marked with a tick.

To hide the Debug window, select the Debug window item in the menu once more.

Note

The debug mode slows the system down and uses a lot of system resources. We strongly recommend to 
enable debug mode for debugging purposes only and to disable it when all the settings are completed.
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1.

2.

3.

Configuring log file parameters
You can set log keeping parameters both on the Axxon PSIM setting panel in the Tweaki.exe utility (see The Settings 
panel of the Axxon PSIM section) and using some registry keys:

The Time of log keeping (hours) parameter means the same as DebugTime registry key. It specifies the 
number of hours for keeping log files. 48 hours by default.
The Maximum size (MB) parameter means the same as DebugSize registry key. It specifies the number of 
megabytes provided for log. 100 MB by default.
The DebugZipDays registry key enables the logs archiving in the .gz format and specifies the time period for 
their keeping. 2 days by default.

Log files are rewritten when the maximum of one of the parameters is reached.

When the Debug 4 debug mode is enabled, the video.run log file displays the most detailed information about the 
file system and memory usage of each camera every 10 seconds. To reduce the number of info lines,, displayed 
every 10 seconds, to 6 (this will reduce the size of the log file), it is necessary to add the StatusInfo=0 key.

An example of the displayed information if StatusInfo=1 or no key:

Uptime: 00:00:12, memory: 423.0 MB
[FS]Health ok.
[FS]Ring cycles count: 0
[FS]Total index in memory size: 62.7 KB
[FS]Total recorders: 4, MemFile: -1, memFile total size: 16.0 MB, last frame skipped 
time: none, WritingQueueSize: 1500, avg speed: 18.99 MB/sec.
[FS]Total readers: 0 (cached frames: 0)
[FS]Total cameras: 4, internal VMDA detectors: 0, external VMDA detectors: 0. zone 
detectors: 0.
[FS]Camera 1. Writing queue: 1 frames(0% of 1500), size: 0.00 MB(0 ms). Streams(1): 1,
 total VMDA detectors 0 (int: 0, ext: 0), zone: 0. Grabber_IP_CAM queue size: 0.
[FS]Camera 2. Writing queue: 0 frames(0% of 1500), size: 0.00 MB(0 ms). Streams(1): 2,
 total VMDA detectors 0 (int: 0, ext: 0), zone: 0. Grabber_IP_CAM queue size: 0.
[FS]Camera 3. Writing queue: 0 frames(0% of 1500), size: 0.00 MB(0 ms). Streams(1): 3,
 total VMDA detectors 0 (int: 0, ext: 0), zone: 0. Grabber_IP_CAM queue size: 0.
[FS]Camera 4. Writing queue: 0 frames(0% of 1500), size: 0.00 MB(0 ms). Streams(1): 4,
 total VMDA detectors 0 (int: 0, ext: 0), zone: 0. Grabber_IP_CAM queue size: 0.
Total registered senders: 1
Objects:
VideoFrame: 38(max: 77 at '09-09-22 14:40:13.014')
AudioFrame: 0(max: 5 at '09-09-22 14:40:08.816')
Msg: 73(max: 130 at '09-09-22 14:40:06.733')
Active[1]
SendVideoFrame(local=1,compressed=1) to 'TAG-5509.1': value: 0 (max 0), delay = 46
 ms, 09-09-22 14:40:15.548
Inactive[0](no new data for more than 15 seconds)

An example of the displayed information if StatusInfo=0:

Note

Find details in the The Debug window section of The Script object. Programming using the JScript 
language.

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314512084/The+Debug+window
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314512073/The+Script+object.+Programming+using+the+JScript+language
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1.
2.
3.

4.
5.

1.
2.
3.

4.

Uptime: 00:00:12, memory: 427.0 MB
[FS]Health ok.
[FS]Ring cycles count: 0
[FS]Total index in memory size: 52.9 KB
[FS]Total recorders: 4, MemFile: -1, memFile total size: 16.0 MB, last frame skipped 
time: none, WritingQueueSize: 1500, avg speed: 7.42 MB/sec.
[FS]Total readers: 0 (cached frames: 0).

Find more about registry keys in Registry keys reference guide.

Example.

The Time of log keeping (hours) is 720 hours (1 month) and the Maximum size (MB) is 100 MB.  

One week later the size of log file is 100 MB. It starts being rewritten though the log is kept less than it was specified. 

And if DebugZipDays has the value equal to the time period in days to keep logs, then logs are not rewritten − they 
are archived in the *.gz format and are kept for so long as it was specified in DebugZipDays parameter.

4.4.2 Extended setup of the distributed architecture
Extended setup of the distributed architecture is performed in the Connection section and is intended to create 
backup connections between the client and other cores (servers) in case of losing connection with the main core. 
Backup connections must be set up for each client individually.

To create a backup connection between the client and a core, do the following:

Stop the Axxon PSIM software if it is running.
Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility section).
Select the Connection section in the tree that is located on the left side of the utility window (see The 
settings panel of the Connection section).
Specify the computer name and IP address in the table.
Click the OK button. 

4.4.3 Changing computer names and IP addresses in the Axxon PSIM configuration 
database

The Distributed configuration node allows changing the computer name and/or IP address in the Axxon PSIM
database.

To change the computer name in the configuration database, do the following:

Shut down Axxon PSIM if it runs.
Start the tweaki.exe utility (see Starting and shutting-down the Tweaki.exe utility).
Select the Distributed configuration in the tree on the left side of the utility dialog box (see The Settings 
panel of the Distributed configuration section).
Select the database containing the computer name to be changed using the Select database (1) or Use 
current DB (2) buttons.

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314513094/Registry+keys+reference+guide
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5.

6.

7.

8.

1.
2.
3.
4.

As a result the Available systems (3) table will show all computer names registered in the selected 
database.
To select the computer name to be changed in the Available systems table, right-click an appropriate row. 
The row will be highlighted.
Click the button next to the New system ID (4) field to see the drop-down list of available computer names. 
Select the required computer name in the list. The selected name will appear in the New system ID field. 
Name can also be entered in the field manually.
Set one of the following checkboxes: Update Protocol (5) checkbox to replace the computer name in the 
events log, or the Clear protocol checkbox to delete all records in the log. Only one of two checkboxes 
should be set.
Click the Update DB button (7). The progress of replacing computer names for a new one will be displayed in 
the field below the Update DB button (8).

To change the IP address in the configuration database, do the following:

Do steps 1-4 of the previous instructions.
Select the IP address to be replaced from the drop-down list (9).
Enter a new IP address into the field (10).
Click the Edit button (11).

The IP address in the database will be changed.
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3.

4.

5.

6.

1.
2.
3.

4.

4.4.4 Limiting memory usage by an MS SQL server
A certain amount of disk space is allocated for the SQL server for storing its data, functions and other internal 
structures. Allocated RAM is determined by default by the total RAM resources available for the SQL server in the 
system. The Tweaki.exe utility allows limiting the amount of RAM allocated for the SQL server. Do the following:

Close the Axxon PSIM software if it is open.
Start the Tweaki.exe utility (see Starting and shutting-down the Tweaki.exe utility section).

Select the Configure MSDE (MS SQL) node in the tree on the left side of the utility dialog box (see The 
Settings panel of the MSDE (MS SQL) configuration section).
Select the MS SQL database to limit the allocated RAM by doing one of the following using Select 
database (1) or Use current DB (2) buttons.
In the Maximum memory usage (MB) (3) enter the required amount of memory to be allocated for the SQL 
server.
Click the OK button (4).

4.4.5 Re-indexing the audio and video recordings archive
To re-index the audio and video archives, do the following:

Close the Axxon PSIM software if it is open.
Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility).
Select the Video Subsystem node in the tree on the left side of the utility dialog box (see The Settings panel 
of the Video subsystem section).
Click the Rebuild Index button to delete the INDEX folder with .idx files containing the indexes to the video 
recording files in the archive.

Note.
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Click OK.
Start the Axxon PSIM system again. A new INDEX folder will be created in the video archive folder, containing 
new indexes.

This completes re-indexing of the database.

4.4.6 Testing video capture cards
To test a video capture card, test its channels using the Testing video capture cards module of the Tweaki.exe 
utility. Do the following:

Shut down the Axxon PSIM software if it is started.
Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility section).
Select the Testing video capture cards node in the tree on the left side of the utility dialog box (see The 
Settings panel of the Testing video capture cards section).
Press Test button.

The Board field will display the name of the video capture card, and the Channels state table will show the 
information about each channel of the card (number and status). The confirmation of successful testing will be 
displayed to the right of the Channels state table.

Pressing the button  Rebuild index sets the value of parameter IndexRebuilding=1 in the register’s 
branch of OS Windows: HKLM\SOFTWARE\AxxonSoft\PSIM\VIDEO for 32-bit system 
(HKLM\SOFTWARE\Wow6432Node\AxxonSoft\PSIM\VIDEO for 64-bit). Alterarchive reindexing the 
value of the parameter IndexRebuilding=0 is automatically set. When Axxon PSIM software is run 
together with IndexRebuilding=1 parameter, the archive is reindexed without any attempt to reas it 
from *.idx files.
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5 The utility for collecting configuration data on servers and RWS 
for the Technical Support

5.1 The purpose of the Support.exe utility
The Support.exe utility is designed for collecting information about the configuration and operating status of the 
hardware, OS Windows and the Axxon PSIM™ system. The utility generates an archive that can be used by AxxonSoft 
Technical Support Service for troubleshooting purposes. In case of system malfunction or errors in the Axxon PSIM™ 
system, do the following:

Go to the AxxonSoft tech support server:  https://support.axxonsoft.com/.
Register a new account on the tech support server or log in the registered account.
Create an issue for tech support. Attach an archive generated by Support.exe utility.  

Information on the issue progress will be sent to the email specified at registration.

5.2 Starting and shutting-down the Support.exe utility
To run Support.exe utility, use one of the following methods:

From the Start menu of OS Windows: Start -> All programs -> Axxon PSIM -> System’s information 
gathering utility
From the Tools folder of the Axxon PSIM program folder: <Axxon PSIM>\Tools\Support.exe

After running the Support.exe, the Support – Collecting info about system utility dialog box is displayed.

How to get technical support

https://support.axxonsoft.com/
https://docs.axxonsoft.com/confluence/spaces/SUPPORT/pages/147360014/How+to+get+technical+support
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To close the Support.exe utility, click the Close button.

5.3 The Support interface description
Support.exe utility interface includes the following elements:

Short directions for using the Support.exe (1).
A group of settings for specifying data set collection time period (2).
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Collect button to run the process of gathering information (3).
Filed of displaying the information (4).
Table to display and select steps of gathering information, it includes two columns – Step and Status. In the 
Step column, the short characteristics of information gathering process step is displayed and the step can 
be cancelled before the information gathering starts. In the Status column there is displayed process-bar 
and time, spent on information gathering (5).

To close the Support.exe utility, click the Close button.
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5.4 Collecting information about videoservers and remote workstations 
using the Support.exe utility

To collect the information using the Support.exe utility, do the following:

Start the utility.
If necessary set the dump and log files collection parameters:

In the Collect dump files for ___ days field specify the number of days for which dump files are to be 
included into the data set for technical support (1).
In the Collect log files for ___ days field specify the number of days for which log files are to be 
collected into the data set for technical support (2).

By default, all available system information is collected. If necessary, uncheck the boxes next to the 
information collection steps that should be skipped (3). If unchecked, information is not collected at the 
corresponding step.
Some stages of information collection are mutually exclusive, for example, you cannot simultaneously select 
the Creating an archive copy of the MS SQL Sever database and Creating the archive copy of the DB 
without the protocols checkboxes.
Some steps cannot be excluded, including Compressing files and Removing temporary files.
Click the Collect button (4).

The data collection process will start. Upon completion, the result of information gathering on each step is 
displayed in the Status column (5), while the information area will show the link to the newly generated file – 
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support.7z (6).

Follow the Open Folder with Support.7z File link to view the archive (6).
The archive is saved in C:\Users\%current user name%\Documents\Support\.
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6 The Fps.exe utility for productivity estimation

6.1 The purpose of the Fps.exe utility
Productivity measurement fps.exe utility is used to estimate productivity of video processing.

Estimation is done in the following way:

Segmentation of the given video fragment for a set of frames in jpeg format.

Compression and/or decompression  of the created frame set.
Calculation of productivity parameters − number of processed fps with defined resolution and colour.

6.2 Starting and shutting-down the Fps.exe utility
To start fps.exe, do one of the following procedures:

Start the utility from the Windows taskbar. Click Start, then Programs, then Axxon PSIM, then Tools, then 
FPS testing utility.
The fps.exe utility is available from the Start menu with the following installation types of the Axxon PSIM
software: Server, Remote administrator workstation, Remote client.
Start the utility from the Tools folder of the Axxon PSIM program folder: <Axxon PSIM>\Modules64\fps.exe.

After starting the fps.exe utility there will be a dialog window Video processing FPS tester.

Note.

If the video fragment is not set, the utility generates pattern set of frames. When necessary the 
utility may store the created set for fames to the selected directory.

Note.

 Compression is not available on the Cilent. Playback of a previously recorded video, or a video being 
received over the network in real time, is available.
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To close fps.exe utility click   in the right upper corner of the utility’s dialog window.

6.3 Using the Fps.exe utility

•

•

•

On the page:

Selecting the video 
source
Setting the check 
parameters
Running the check and 
reading into its results

To check productivity of video processing, do the following:

Start the fps.exe utility (see Starting and shutting-down the Fps.exe utility).
Select the video source.
Set the check parameters.
Run the check and read into its results.
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6.3.1 Selecting the video source
The video source can be either an archive file or a video server archive recorded on specific cameras.

If the video source is an archive file, select it as follows:

Click File and then double click the required file in the Windows standard Open box (1).

The full name of the selected file is displayed in the Video source field (2).

If the video source is a video server archive, make sure the Axxon PSIM is running on that server and all the required 
cameras are created in the hardware tree before performing the check.

Select the archive video source as follows:

Click Server (1). The Cameras dialog box opens.

In the IP field, specify the IP address of the Axxon PSIM video server (2).
Click Get (3). If connection with the server is established, the Cameras field displays the list of cameras.

Note.

The field Video Source File is not required to run the check on an emulated pattern set of frames.
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Set the check boxes next to the cameras to check performance using their archive (4) or set the Select all
check box to select all the cameras in the list (5).
Click OK (6).
The selected cameras are added into the Video source field (7).

6.3.2 Setting the check parameters
Set the parameters of performance check as follows:

Activate Compression check checkbox to check how many fps  the given computer can compress (1).

Activate Decompression check checkbox to check how many fps  the given computer can decompress(2).
Select the Copy for stream check box to create a separate copy of each stream file in the RAM in order to 
avoid conflicts during the check (3). This function increases memory consumption when running the fps.exe 
utility.
Select the required compressor version from the drop-down list Codec (4).
Enter the required number of emulated cameras in the field Channels amount (5).

In the Number of CPU cores in use field specify the number of CPU cores to be used for performance check 
(6).
Select the required value of frames compression from the dropdown list Quality (inversely to compression 
level) (7).
When necessary, set the directory where frames extracted from the video would be unzipped by clicking 

 next to the Jpeg images storage folder field (8).

6.3.3 Running the check and reading into its results
Click the Start button to run video processing tester (1).

Note.

This setting is actual only with emulation of pattern set of channels.
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As a result, parameters of video processing productivity will be displayed in the title bar of the utility window (2).

Productivity parameter Description of parameter

Compression total number of frames that can be compressed in one 
second

Decompression total number of frames that can be decompressed in one 
second

Ratio compression ratio

Version selected version of the compressor

Width frame width

Height frame height
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Productivity parameter Description of parameter

Color if the frame is in color

CPU number of CPU cores in use

Compressors $ decompressors per thread number of compressor instances per CPU

If the Jpeg images storage folder is selected, the frames for testing video processing will be recorded to the 
selected .jpeg files storage folder.

The example of the emulated frame is shown below:

To stop the testing process, click the Stop button (3).
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7 The SignCheck.exe utility for checking the authenticity of 
exported frames

7.1 Starting and shutting-down the SignCheck.exe utility
To start the SignCheck.exe utility, do one of the following:

Start the utility from the Windows taskbar. Click Start, then Programs, then Axxon PSIM, then Tools, then 
Check Digital Signature.
The SignCheck.exe utility is available from the Start menu with the following installation types of the Axxon 
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PSIM software: Server, Remote administrator workstation, Remote client.

Start the utility from the Tools folder of the Axxon PSIM program folder. Example: C:\Axxon 
PSIM\Tools\SignCheck.exe.

The SignCheck dialog box will open.
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To close the SignCheck.exe utility, click the Close button.

7.2 The purpose of the SignCheck.exe utility
The SignCheck.exe utility is designed for checking the authenticity of a frame exported into BMP or JPEG format 
using the Converter.exe utility.

7.3 Using the SignCheck.exe utility
To verify the frame authenticity, do the following:

Start the utility (see Starting and shutting-down the SignCheck.exe utility section).

Select the file with exported frame to check, using the   button and a standard dialog box for opening 
files.

The SignCheck window will show the information about the selected frame.

The following information is displayed:

AxxonSoft export frame – digital signature title.
Frame time – date and time stamp of this frame in the recording.
Export time – date and time of exporting this frame to a file.
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Camera – ID of the camera from which the recording was made.
System – the software that made the recording.
Computer – name of the computer this software is installed on.
User – user name of this computer.

If the frame cannot be authenticated, or the digital signature is missing, the "Verification failed” message will be 
displayed.
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8 The Convert.exe utility for correcting modification dates of 
video archives

8.1 The purpose of the Convert.exe utility
The Convert.exe utility is designed for restoring changed creation dates of video archive files. For example, file 
creation dates may be changed (corrupted) while transferring an archive from one computer to another. This may 
lead to incorrect playback of the archive.

8.2 Starting and shutting-down the Convert.exe utility
The Convert.exe utility can be operated in two modes:

Correction of records creation dates. To use this mode, start the utility from the Tools folder of the Axxon 
PSIM installation folder. Example: C:\Program Files (x86)\Axxon PSIM\Tools\Convert.exe.
Correction of records creation and modification dates. To use this mode, start the utility from the Tools 
folder of the Axxon PSIM installation folder with the -FULLMODE parameter.

The Convert.exe utility dialog box will open.

To shutdown the Convert.exe utility, click the Close button.

8.3 Restoring changed creation dates using the Convert.exe utility
The Convert.exe utility allows restoring the creation date of a video archive file. To make the restoration, start the 
utility (see the Starting and shutting-down the Convert.exe utility section). A console window will open starting the 
process of searching the Video folder on each of the available disks. Then, replacing of modification date for 
creation date will start automatically. This process will take some time depending on the archive size. For example, 
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restoring dates in a 500 MB archive will take about 10 seconds. When all dates are replaced, the Convert.exe window 
will close by itself.

8.4 Working with the Convert.exe utility using the command prompt
One can work with the Convert.exe utility using Windows command prompt. The following startup parameters are 
in use:

TZ +hh:mm – changing date of file creation and modification for hh hours and mm minutes.
PATH – specifies the path to the archive folder with files date of creation (modification) of which is to be 
restored.
FULLMODE – running the utility in order to correct the date of creation and modification.
FORMAT is similar to FULLMODE. It also converts archive files to a format optimized for high-resolution 
archiving. The execution time of the FORMAT operation is comparable the the time required for a full 
conversion of the archive on the disk, because it requires reading every frame and creating a backup copy of 
the files while they are being converted. After the format of the archive or record has been updated, the 
execution time of subsequent conversions in FULLMODE will become the same as during an ordinary 
conversion.

Examples of commands for working with the Convert.exe utility using the command prompt:

Convert.exe PATH "H:\Video\03-09-12 15" FULLMODE 
Running this command the Convert.exe utility will restore the date of file creation and modification in H:
\Video\03-09-12 15 folder.
Convert.exe TZ +01:00
Running this command the time of file creation and modification will change for an hour. For instance, the 
“17-09-12 13” folder will be renamed as “17-09-12 14”.

Note.

These examples assume using a command prompt in <Axxon PSIM>\ Tools folder.
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9 The ddi.exe utility for editing database templates and external 
settings files

The ddi.exe utility is designed for editing external system settings files (*.ddi) and the templates of the main 
database (psim.dbi and psim.ext.dbi).

The ddi.exe utility is started from the Start -> All Programs -> Axxon PSIM -> Tools -> System configuration 
menu.

The ddi.exe utility is available from the Start menu with the following installation types of Axxon PSIM: Server, 
Remote administrator workstation, Remote client.

The utility can also be started from the Tools folder of the Axxon PSIM program folder.

After the changes are made to *.ddi and/or *.dbi files, update the main database. For this use the idb.exe utility (see 
The idb.exe utility for converting databases, selecting database templates and making backup copies of databases
section).

9.1 Editing psim.dbi and psim.ext.dbi database templates using the 
ddi.exe utility

To edit the template of the main database, open it using the File -> Open menu. The template files are stored in the 
root of the Axxon PSIM program folder.

Psim.dbi file contains the list of main tables and fields of the database. User-defined tables and fields are stored in a 
separate file – psim.ext.dbi. This file is made separate from the main file, to eliminate the need to re-insert user-
defined tables and fields into the main file, in case of Axxon PSIM system update. The contents of these files are 
merged upon Axxon PSIM start-up.

To view the database template, open the DBI tab in the top left corner of the window. The list of the tables of the 
main Axxon PSIM database will be displayed in the left panel. The right panel will show the list of fields of the 
selected database.

Note.

 If changes were made to .ddi or .dbi files using the ddi.exe utility and these files were installed along with 
Axxon PSIM, then these files will be deleted while deleting with configuration upload. .ddi and .dbi files 
added manually will be saved.

Note.

To open the recently used file, select the Last files item in the File menu or open the context menu in the 
Names tab.

Note.

The Paste from file item in the File menu allows opening several files by adding tables, described in other 
dbi files, to the open dbi file.
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To delete, add, edit or copy object fields, use the table on the left of the utility box.

The following parameters of the table fields are displayed:

Field name – the name of the field in the database.
Type – data type of the field contents. Available types:

BIT – checkboxes taking logical values Yes and No;
CHAR – fields with a few symbols;
DATETIME – date and time in the following format: date – dd-mm-yyyy, time – hh:mm:ss;
DOUBLE, INTEGER, SMALLINT – numerical fields of corresponding types;
TEXT – fields with the text.

Size – maximum number of units of the specified format in a field.
Description – field name shown in the interface.

The database is to be refreshed after the changes were made.

9.2 Editing the external setting file (Axxon PSIM.ddi) using the ddi.exe 
utility

To edit the external settings file (psim.ddi), open it using the File -> Open menu. This file is stored in the root of the 
Axxon PSIM program folder.

Note.

To open the recently used file, select the Last files item in the File menu or open the context menu in the 
Names tab.
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The external settings file contains the information about objects and events loaded into the system configuration, 
graphical symbols for various object states on the map, and the transition rules from one object state to another.

The purpose of editing can be software localization or expanding/limiting its functionality (for example, removing 
unused objects from the system).

The database is to be refreshed after the changes were made.

9.2.1 General information on editing the external setting file
To start using the utility, open the DDI tab in the top left corner of the utility dialog box.

The left side of the dialog box will display all system objects loaded into the configuration. The right side of the 
dialog box shows the properties panel for the selected object. This panel consists of several tabs: Names, Events, 
Reactions, Icons, States, and Transition rules.

To delete, add, edit or copy object properties, right-click a cell in the tab or the list of system objects to open the 
context menu. You can also use Ctrl+C and Ctrl+V to copy and paste lines from one object to another. Select the 
whole line(s) or just a cell(s) in it to copy by Ctrl+C. Delete lines with Delete key.

To edit the object properties, use the tables on the right of the ddi.exe utility box.

9.2.2 The Names tab
This tab contains the table with three fields:

Object – object ID in the system.
Name – the name of the object in the system.
Group name – the name of the group the object will be assigned to upon creation. If this field is left blank, 
no group will be created. Objects of different types may be assigned to the same group given that they have 
the same parent object (e.g., Sensor and Relay can be included to the "Sensors and Relays" group and so 
on).

By default all objects, the description of which the ddi file contain, are displayed in the table. To find an object, 
type-in the object name or ID in the Search by name field. As a result the table will contain all object names in the 
system that exactly or partially match the word typed in this field.

Note.

The Paste from file item in the File menu allows opening several files by adding tables, described in other 
dbi files, to the open dbi file.

Note.

 Changing the external settings file may lead to system failure. Create a backup copy of the file before 
editing it.
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9.2.3 The Events tab
This tab contains the list of the system events that the selected object can create. Each event has the following 
editable parameters:

Name. The event identifier.
Description. A short description of the event.
Processing messages. The type of window to open on event occurrence: alarm window or information 
window.
Support audio. The attached .wav files to be played when the event occurs.
Disable network connection. A local event only. If this checkbox is set, other computers on the network will 
not be notified when the event occurs.
Disable logging. By default, all events are displayed in the Event log. Set the checkbox not to log the event 
or record it in the database.
Windows log. Set the checkbox to log the event (see step 6) to Windows log. If the event is not logged, then 
it cannot be logged to Windows log.
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9.2.4 The Reactions tab
This tab lists all reactions that the object can make in response to events. Each reaction has the following 
properties:

Reaction – reaction ID.
Description – short description of the reaction.
Arming  – additional property of the reaction, arming a region.

Note

You can create only the events that are available for the selected object (created at the stage of the system 
programming). Initially all of them are in the psim.ddi file.
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9.2.5 The Icons tab
This tab lists the graphical symbols (icons) that represent the selected object on the map. The part of the name 
used for identifying the file in the .bmp, .jpg or .png format is specified in the File name column. Image files are to 
be stored in the Bmp folder in the Axxon PSIM program folder (for example, C:\ Program Files\Axxon PSIM\Bmp).

Note.

You can create only the reactions that are available for the selected object (created at the stage of system 
programming). Initially all of them are in the psim.ddi file.
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If default icons are to be in use for the same states of objects of the same type, the def icon should be specified on 
this tab (By default). See The States tab section for more information.

9.2.6 The States tab
This tab lists all states of the selected object. The states have the following properties:

Name – state ID.  
Image – part of the name in the .bmp format that represent the object state on the map. For example, if the 
zone_fire file name was selected in the Icons tab, and the image of the selected ARMED state is arm, then the 
zone_fire_arm.bmp  file will be in the Bmp folder.

The default icon for the states can be set. For this, set the def icon (By default) on the Icons tab. For example, if 
there is no zone_fire_arm.bmp icon for the ARMED state, then the def_arm.bmp icon will be searched. This avoids 
duplicating icons if one state for the different types of the object icon should be displayed identically.

Note.

 If the file ID is not set in the Icons tab, then the file name will consist of the object ID and part of the file 
name specified in the Image column.
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Description – short description of the state.
Blinking on alarm – option of displaying object state.

 

9.2.7 The Transition rules tab
Transition rules connect the events generated by objects, and the states of these objects. Each rule consists of the 
starting state of the object, an event, and an ending state that the object will take after the event.

The table lists the transition rules from one object state to another. Each rule has the following properties:

Event – identifier of the event triggering the transition.
Transition from state – identifier of the object state before the event took place. If this field is left blank, the 
rule will apply to all starting states.
Transition to state – identifier of the resultant state of the object.

Note.

If the object is displayed on the map as a polygon, circle or line, then the color of these figures can be set 
for each state.  
For this specify the color in the R:G:B:A format after the icon name (separated by $) in the Image column or 
specify the color only in this format instead of the icon name. Here are the examples of the Image column 
contents:
255:0:0 – red color is set for the state.
alarm$255:0:0 – icon and red color are set for the state.
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9.2.8 Example of editing the Axxon PSIM.ddi file to reduce database load
When changing the ddi file events, reactions, etc. can be added, modified or deleted. 
To reduce database load modify the psim.ddi file as follows: 

Open the psim.ddi file in the ddi.exe utility.
Select the CAM object.

Go to the Events tab.
Set the Disable network connection and Disable logging checkboxes checked for the MD_START (Alarm) 
and MD_STOP (Alarm end) events.
Save the file.
Update the database using the idb.exe utility (the Update database button, see Interface elements of the 
idb.exe window).

When these actions are performed the events from the main motion detection tool are not recorded and sent to 
other cores. This reduces the database load.

https://docs.axxonsoft.com/confluence/spaces/Int410en/pages/124980950/Interface+elements+of+the+idb.exe+window
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In order the psim.ddi file is not substituted it is to be saved with another name at step 5 - e.g. "psim_1.ddi". Thus, 2 
files of external settings are saved in the Languages catalog: source file and modified one. The idb.exe utility loads 
them in alphabetical order. As a result the psim_1.ddi file is loaded the last one and its parameters are applied 
when database is updated.

If the event list in psim_1.ddi is different from the original psim.ddi, e.g. some events are added or deleted, then the 
event list is merged by idb.exe DB update.

When installing a new Axxon PSIM version the psim_1.ddi file is not affected by the installation wizard and changes 
are saved.

Important!

When updating Axxon PSIM the modified psim.ddi file is substituted with the file by default.

Important!

When deleting Axxon PSIM without saving the configuration the entire Axxon PSIM catalog (including 
modified files) is deleted. In this case the modified files are to be manually backed up, e.g. to C:\Temp, 
under after reinstallation they are to be copied to <Axxon PSIM installation folder>\Languages\en.
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10 The Arpedit.exe utility for creating user dialog windows
The Arpedit.exe utility is designed for creating dialog boxes. It allows tailoring Axxon PSIM system to particular 
monitoring and security tasks of the customer.

The Arpedit.exe utility is in the “Arpedit” folder (<Installation directory>\Axxon PSIM\Tools\Arpedit). Detailed 
information on the utility is given in User's Manual for ArpEdit (it is located in pdf format in the same folder too).

10.1 User's Manual for ArpEdit

10.1.1 Introduction into User's Manual for ArpEdit

•

•

On the page:

The purpose of 
the document
The purpose of 
ArpEdit

 

The purpose of the document
The User’s Manual for ArpEdit is a reference tool and contains information needed to work with the ArpEdit. This 
utility is included in the basic distribution of the Axxon PSIM software package.

The following materials are included in this manual:

General information on ArpEdit.
User guidelines for ArpEdit.

The purpose of ArpEdit
ArpEdit is designed to perform the following functions:

Creating badge forms for the Access Control Service module (in the form of files with the .arp extension).
Creating user dialog boxes (in the form of files with the .dlg extension).

Note.

The dialog box is connected to Axxon PSIM via a system operator object query window and displayed as a 
result of the macro commands that are specifically designed to work with this dialog box. Thus, the ArpEdit
utility allows you to completely adapt Axxon PSIM to solve particular problems of control and security at a 
production facility.
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a.
b.
c.

2.

10.1.2 General principles of operating ArpEdit

Starting and shutting down ArpEdit
Launching ArpEdit can be done in one of the following ways:

Launch from the Axxon PSIM installation directory. To launch the ArpEdit utility from the Axxon PSIM 
installation directory, follow these steps:

Go to the folder where you installed Axxon PSIM (default directory is C:\Program files\Axxon PSIM).
Go to the Tools\Arpedit folder.
Launch the file arpedit.exe.

Launch from the Start menu. To launch the ArpEdit utility from the Start menu, select the menu item Create 
dialog windows, located in Start → Axxon PSIM.

Closing the operation of the ArpEdit utility may be done in one of the following ways:
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In the system menu of the ArpEdit utility, in the File heading, select Exit.

Click .

If the document contains any unsaved changes, a Report editor dialog box appears.

To confirm the changes, click Yes. To exit the program without saving the changes, click No.

The utility window will close.

Description of the interface elements of the ArpEdit utility
The ArpEdit utility window contains the following key interface elements:

Note.

More information on the interface elements of the ArpEdit utility can be found in the appendix (see 
APPENDIX 1. Interface elements of the ArpEdit utility).
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1.

2.

The System menu. Provides access to file operations, editing functions and window display settings for the 
ArpEdit utility (1).

Toolbar. Provides access to key features of the utility (2).
Workspace. Contains elements of the badge or dialog box, add users, and allows for the management of 
placement and sizes (3).
The status bar displays information about the actions produced by the utility (4).

Creating ArpEdit objects
ArpEdit objects are divided into the user interface and variable elements. To create a new object in the workspace, 
follow these steps:

Select a section of the workspace where you want to add an item, click on it. The selected part will be 
highlighted in blue.

Go to the ArpEdit toolbar.
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Select the object to be added by clicking the left mouse button on the appropriate icon on the toolbar (see 
description below).
Click the left mouse button at the point in the workspace in which to place the upper left corner of the 
object.

ArpEdit objects:

Name Description Purpose

Text Fixed text field Display fixed text field

Name Description Purpose

Variable Variable text field, hidden text box, button 
or drop-down list

Displays information from the 
database when creating badges
Variable when creating dialog 
boxes

Name Description Purpose

Line A line of given length and direction Design element

Name Description Purpose

Frame Set rectangular frame sizes Design element

1.
2.

1.
2.

Note.

The dimensions of the created object can be changed in two ways:
By dragging the right or bottom edge of the object with the mouse.
By setting new values for the height and width of the object in the field box (see Setting field 
variables).

The position of the created object can also be modified in two ways:
Dragging the object with the mouse from the top or left edge.
By setting the new position of the object in the field variable window (see Setting field variables).
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Name Description Purpose

Square Set filled square sizes Design element

Name Description Purpose

Image Image placed at a specific location Insert client photographs in the badge form for 
printing

Creating a new object is finished.

Setting object display variables

Setting field variables

To set the field variables, follow these steps:

In order to set the field variables, it is necessary to select the variables of the object in the workspace, and 
open the Variables field in one the following ways:

Click  on the toolbar;
In the object functional menu, select Properties.

Note.

The object functional menu is opened by right-clicking anywhere inside the object.
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2.

3.
a.
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i.

ii.

4.

5.
6.

a.
b.

7.
a.

b.
8.

a.
b.

The Field variables window will appear.

In the text field (1) enter information describing the field:
Enter text in Text field, which will be displayed in the text field.
For Variable, enter the variable name.
For an Image, enter the image address in quotes. The image must be placed in one of the following 
folders:

In the Axxon PSIM software installation folder (e.g. C:\Program Files\Axxon PSIM), then in the 
field (1) enter the image name, e.g. “image.bmp”.
In the Bmp folder of the Axxon PSIM software installation folder (e.g. C:\Program Files\Axxon 
PSIM\Bmp), then enter the image file address as "Bmp\image.bmp" or "Bmp/image.bmp".

If you would like to fill in the text field with data from a text file or enter a large amount of data, then click the 

 button (2) and use a text editor (see the section in APPENDIX 2. Entering text using the editor).
Set the Alignment settings for the desired justification of the text within a selected object (3).
Select units of measure which will be used to size the object:

If the size of the object will be given in millimeters, then check the in mm box (5).
If the size of the object will be given in characters [symbols], then check the Width in symbols box 
(9).

Set the position of the upper left of the object in one of the following ways:
Specify the absolute coordinates of the object. In this case you should indicate the position of the 
upper left corner by setting the X-axis in the X field, and the Y-axis in the Y field: (6)
Specify the relative coordinates of the object. In this case you should check the Relative box (4).

The width and height of the object can be set in one of the following ways:
Specify the width of the object in the W field, and the height of object in the H field (7).
Specify the coordinates of the lower-right corner. To do this, check the X2, Y2 box (8). The W and H 
fields will be by X2 and Y2. After this, specify the coordinates of the lower-right corner of the object 

Note.

The size of the object is given in characters [symbols] by default.
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11.
12.

1.

using the X2 field for the x-axis and the Y2 field for the y-axis.

Specify the line thickness in the Line thickness field in the desired units (10).
If a custom object should be on the badge or there is a dialog window, but it should not be visible to the 
user, then check the Hidden box (11).
If the object must be part of a group, check the Group box (12).
Click OK (13).

Setting the variables is completed.

Setting the text font

To set the text font, follow these steps:

Select Font from the menu.
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2.

1.

Using the standard font selection menu, set the text display settings.

Setting the text font is completed.

Setting the color

To set the color, follow these steps:

Select Color from the menu.
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Using the standard color selection menu, select the color desired for the object.

Setting the color of the object is completed.

Setting the background color of the object

To set the background color of the object, follow these steps:

Select Background color from the menu.
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1.
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Using the standard color selection menu, select the background color desired for the object.

Setting the background color of the object is completed.

10.1.3 Creating dialog boxes

Creating a dialog box form
In the Axxon PSIM dialog box, objects will be displayed in the ArpEdit workspace.

Create a dialog box form in the following order:

Create design elements in the workspace.
Create variables in the workspace.
Configure the design elements in the workspace.

Creating design elements

The design elements in the dialog window correspond to their appearance in the workspace. You can add the 
following design elements:

Square (1). Adding a square in the workspace is performed by clicking the  button on the ArpEdit utility 
toolbar.
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Line (2). Adding a line in the workspace is performed using one of the following buttons:  on the
ArpEdit utility toolbar.
Text (3). Adding the text field with the non-edited information in the workspace is performed by clicking the

 button on the ArpEdit utility toolbar.
Variable (4). Adding the editable text field (hidden field, button, or drop-down list) in the workspace is 

performed by clicking the  button on the ArpEdit utility toolbar.
Frame (5). Adding a frame in the workspace is performed by clicking the  button on the ArpEdit utility 
toolbar.

Creating design elements is complete.

Creating variables

Creating variables in the workspace is done using the  on the ArpEdit toolbar. Depending on the variable setting 
they may be displayed in the dialog box as follows:

Editable text field (1). Additional configuration after adding is not needed (5).

Button (2). In order to display a variable as a button in the dialog box, you must configure it after adding it to 
the workspace, as follows (6):
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a.

b.
c.

d.
3.

a.

Click  on the toolbar. The Field options window will open.

Place a colon in front of the variable name (1).
In the Calculation formula field, specify the variables for the DoReact function using quotes “,” – 
which will be used with the button is clicked (2).
Click OK.

Drop-down list (3). In order to display a variable as a drop-down menu in the dialog box, you must configure 
it after adding it to workspace, as follows (7):

Click  on the toolbar.
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c.
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e.

1.
2.

3.

Double click on the frame around the variable name. The Field options window will open.

Check the Drop-down menu [Pulldown list] box (1).
If you would like to manually specify menu values, then you must enter the desired value in the Fill 
list field, using the character “|” as the separator between values (2). To enter a large amount of text 

or to paste text from a file, click  and use the editor (see the section in APPENDIX 2. Entering text 
using the editor).
Click OK.

Creating variables is completed.

Setting up workspace objects

After adding interface elements and variables to the workspace, it is necessary to configure them. Configuring 
interface elements includes specifying their display variables (see the section on Setting object display variables).

To configure a variable, follow these steps:

Click  on the toolbar.
Double click the left mouse button on Variable menu item that you wish to set. The Field options window 
will open.
Enter the name of the variable in the Text field (1).
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Enter the Default value in the field, of the variable that will be the default value (2).
Set the switches (3) to the position corresponding to the type of variable.
Specify the format for the variable. To do this you need to check one or more of the checkboxes in front of 
the format corresponding to the variable (4).
If you do not want to allow the value of the variable in the dialog box to be changed, then check the Non-
edit box (5).
If you want the value of the variable to be present in the dialog box, but not visible, then check the Hidden 
box (6).
Click OK (7).

Configuring variables is completed.

Note.

If there is a colon in front of the variable name (for example :var), the when creating a dialog box it 
will be displayed as a button with the same name (var). At the same time, in the Calculation 
formula field (3) the variables for the DoReact function will be displayed, delineated by the “|” 
character.
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Saving the dialog box form
To save the dialog box form, follow these steps:

 Select File, then click Save (1) or Save as… (2) to save the file under a new name.

Using the standard save file dialog, save the file with a .dlg extension [suffix].

Saving the dialog bog form is completed.

Opening a dialog window in Axxon PSIM
To open a dialog window in Axxon PSIM, do the following:

Note.

The file extension should be entered manually in this case.

Important!

In order to have access to the saved dialog form file in Axxon PSIM, it should be saved in the following 
folder: <Path to installation directory of Axxon PSIM>/Program.
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Create the Operator query panel object on the basis of the Computer object on the Hardware tab of 
the System settings window.

Go to the settings panel of the Operator query panel object.

Specify the window coordinates:
In the X field, specify the coordinate on the horizontal axis.
In the Y field, specify the coordinate on the vertical axis (1).

From the drop-down list in the Type column, select the type of the object that generates the appearance of a 
new dialog window (2).
From the drop-down list in the Number column, select the number of the selected object type in the system 
(3).

Attention!

When you create the Operator query panel object, specify the name of the file of the dialog 
window form saved in the corresponding directory in the Number field.
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Double-click the cell in the Name column (4). The name of the selected object is automatically displayed in 
this cell.
In the Event column, select the action that is performed after the corresponding event occurs in the system 
(5).

Dialog windows are used when programming Axxon PSIM. For detailed information about the embedded 
programming language, see Guide for creating scripts (programming).

Configuration of the Operator query panel object is described in detail in the Administrator's Guide.

Example of creating a dialog window to count the number of movements
This section provides the example of creating a dialog window to count the number of movements. 
To create such a dialog window, do the following:

Create the field with the Number of movements text (1).

Create the param variable (2).

Click the button on the toolbar.

Note

In the example shown in the figure, the dialog window created in the form will be displayed if the macro is 
executed.

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314512025/Guide+for+creating+scripts+programming
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314509669/Administrator+s+Guide
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Double-click the frame around the variable name. The Field's options window opens.

Specify the param value as the name of the variable.
Set the Non-edit checkbox.
Save the file with the motion.dlg name in the following folder: <Axxon PSIM installation directory>\Program.
Run Axxon PSIM.
Create the Operator query panel with the motion number in the Axxon PSIM object tree.
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11.

12.
13.

In Axxon PSIM, create the Program object on the basis of the Programs object on the Programming tab of 
the System settings window (1).

Enter the following program text in the field on the right (2):

OnInit(){
param="0";
}
OnEvent("CAM","1","MD_START"){
DoReact("DIALOG","motion","CLOSE");
param=str(atof(param)+1);
DoReact("DIALOG","motion","RUN","param<" + param + ">");
}

From the Time schedule drop-down list, select Always (3).
Click the Apply button (4).

The result of script execution: as soon as movement appears in camera sector 1, the motion operator query panel 
opens, showing the number of (param) movements.

 

Creating a dialog window to count the number of movements is complete.
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10.1.4 Working with badge forms
The ArpEdit utility supports work with the Visitor Management System (see Visitor Management System Module 
Settings and Operation Guide) module and allows you to create badge forms and output them for printing.

Creating a badge form
Before you start to create badge forms, you need to make sure that you have created an Access Control Service 
object, as well as departments and users in Axxon PSIM.

To create badge forms in the Access Control Service, follow these steps:

Select the workspace section where the items will be added to the interface. Each section represents a single 
page.
Create the required number of variables, as follows:

Add a variable to the workspace by clicking  on the toolbar (1).

Click  on the toolbar.

https://docs.axxonsoft.com/confluence/spaces/acfaen/pages/119832706/Visitor+Management+System+Module+Settings+and+Operation+Guide
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Double click the left mouse button on the border of the Variable that you wish to set. This will open 
the Field options window.

In the Field box [field], enter the name of the variable corresponding to the table in the Axxon PSIM 
database: dbo.OBJ_PERSON, from which data will be accessed for printing the badges (1).

Add the required design elements from the ArpEdit toolbar.
In order to allow the printing of photographs of employees on each pass for badge users, the Image should 
be set as follows:
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5.

6.

Select the required Image and click  on the toolbar. The Field options window will open.

In the Field options window, specify the following text string:  “<Axxon PSIM installation 
directory>\bmp\Person\”+id+”.bmp” (1). When outputting the badge to the printer, the id variable will be 
automatically read from the data base, and photography assigned to that ID by Axxon PSIM  will be printed 
on the badge.

Design elements used for badge forms:

Name Description Function

Text Uneditable text field Will display uneditable text information

Name Description Function

Line Line of any given length and direction Design element

Name Description Function

Frame Rectangular frame of a specified size Design element
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Name Description Function

Square Filled rectangle of a specified size Design element

Name Description Function

Image An image placed at a specified location Insert user photographs on badge forms when 
printing

After adding all the required elements in the workspace, you must set the display variables (see section on Setting 
object display variables).

Creating badge forms is completed.

Saving badge forms
To save created badge forms, follow these steps:

From the File menu, select Save or Save as… to save a file with a new name.
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2. Using the standard save file menu, save the badge form file with a .arp extension.

Saving badge forms is complete.

Printing badges
To output badges for printing, select Printer network [Print’s Grid] from the File menu.

Outputting the badge to the printer is completed.

10.1.5 APPENDIX 1. Interface elements of the ArpEdit utility

System menu
The ArpEdit utility system menu provides access to the following functions:
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2.
3.

File operations: creating, opening, saving, printing (1).

Text editing features (2).
AprEdit utility window display settings. In this menu, you can enable or disable the display of the toolbar and 
status bar (3).

Toolbar
The main way to manipulate objects in ArpEdit is via a toolbar, that has buttons to control the utility.

 

Description of the buttons in the ArpEdit utility toolbar:
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Workspace
The ArpEdit utility workspace is designed for the placement of objects in ArpEdit. When the Show sections  button is 
activated, the workspace will be divided into sections by horizontal lines.
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1.

Each section will have its own page. To start editing a section, select it by licking on the dividing line with the left 
mouse button. The selected section will be highlighted in blue.

10.1.6 APPENDIX 2. Entering text using the editor
You can enter text in the variable settings using the built-in ArpEdit editor. This editor should be used when you 
want to fill in a text field with data from a text file or a large amount of data.

To enter text using the editor, follow these steps:

Click  next to the text field.
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Open the Editor window.

Enter text in the text field (1).
If you want to paste the text into a text field from a text file, then click File… (2) using the standard open file 
dialog box, select the required text file. Text from the selected file will appear in the text field (1).
Click OK (3).

Entering text using the editor is completed.
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11 The idb.exe utility for converting databases, selecting 
database templates and making backup copies of databases

11.1 The purpose of the idb.exe utility
The idb.exe utility is designed for database administration in Axxon PSIM software. It provides the following 
functionality:

Connecting to the Axxon PSIM database.
Setting up the database synchronization.
Creating backup copies of a database.
Restoring a database from its backup copy.
Changing the database template (see Interface elements of the idb.exe window).
Separating the events log into an individual database.

11.2 Running and shutting down the utility
Shut down Axxon PSIM before running the idb.exe utility.

The idb.exe utility is run from the Axxon PSIM installation directory. For example: «C:\ Program Files \Axxon 
PSIM\idb.exe».  

The idb.exe dialog box will open.

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314511492/Connecting+the+Axxon+PSIM+database
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314511514/Configuring+database+synchronization
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To confirm the changes and shut down the utility, click the OK button. To shut down the utility without saving the 
changes, click the Close button ( ).

11.3 Interface elements of the idb.exe window
The figure below shows the idb.exe dialog box.
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The table describes the interface elements of the idb.exe utility dialog box.

№ Element 
name

Description Default value Allowed values

1 Select 
data 
source

The drop-down list for selecting the 
database: local Configuration 
database, Event protocol database, or 
a remote database for synchronization

Basic data Basic data – local 
Configuration database

Synchro source – remote 
database for 
synchronization

Protocol – Event 
protocol database

Titles – Captions 
database

Other values are used 
when working with vertical 
solutions
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№ Element 
name

Description Default value Allowed values

2 Descripti
on

The information field that displays the 
description of the selected data source 
from the Select data source dropdown 
list

Axxon PSIM main 
database

"Axxon PSIM" main 
database – local 
Configuration database

Synchro source – remote 
database for 
synchronization

"Axxon PSIM" system's 
external protocols 
database – Event 
protocol database

Titles database – 
Captions database

Other values depend on 
the availability of the 
databases for the installed 
vertical solutions.

3 Use The checkbox for enabling or disabling 
the selected database usage. When set, 
the Configure button becomes active, 
which is used for setting up the 
connection to the database

Checked Checked – database is 
connected

Clear – database is not 
connected

4 Move 
database

The button used to transfer MS SQL 
Server database files (.mdf and .ldf) to 
the specified folder. The user should 
have the rights to create files in this 
folder. When the files are moved, the 
database is automatically attached.

Note. It is possible to move only the local 
DB (Basic data data source). When using 
a remote DB (Synchro source data 
source), files can not be moved

Active Active – the idb.exe utility 
is connected to the MS 
SQL format database

Inactive – the idb.exe 
utility is not connected to 
the MS SQL format 
database

5 Configur
e

The button opens the Data Link 
Properties dialog box to configure the 
database connection. This button is 
active if the Use checkbox is set

Active Active – the idb.exe utility 
is connected to the 
database

Inactive – the idb.exe 
utility is not connected to 
the database
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•

•

•

•

•

№ Element 
name

Description Default value Allowed values

6 The 
Connecti
on string 
informati
on field

The information field displaying the 
summary about the database 
connection parameters

Depends on the 
database 
connection 
parameters, the 
server 
configuration or 
Remote 
Administrator's 
workstation 
configuration 

Displays the combination 
of the following 
parameters:

Provider, Integrated 
Security, Persist Security 
Info, Data Source.

The Provider parameter 
can take the following 
values:

SQLOLEDB.1 – 
when using the MS 
SQL server format 
database;
Microsoft.Jet.OLED
B.4.0 – when using 
the MS Access 
format server 
database

Other values are not used.

The Integrated Security 
parameter can take the 
following values:

SSPI – 
authentication on 
MS SQL server 
using Windows 
account 
information;
parameter not 
shown – 
authentication on 
MS SQL server 
using the user 
login/password, or 
using MS Access 
format database

The Persist Security Info
parameter can take the 
following values:

True – allow saving 
the password for 
automatic 
connection to the 
database;
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•

•

•

№ Element 
name

Description Default value Allowed values

False – do not allow 
saving the 
password for 
automatic 
connection to the 
database

The Data Source
parameter can take the 
following values:

the name of the MS 
SQL server used for 
managing the 
database;
the path to 
the .mdb file of the 
MS Access format 
database

7 Informati
on field 
and the 
Select 
dbi-file 
button

The information field and the button for 
selecting and displaying the database 
structure .dbi file. The updated 
database will have the structure 
specified in this file

C:\Program 
Files\Axxon 
PSIM\psim.dbi

The full path to the .dbi file

8 Informati
on field 
and the 
Select 
dbi-file 
button

The information field and the button for 
selecting and displaying the 
information about the .ddi file with 
system objects, events and reactions

C:\Program 
Files\Axxon 
PSIM\Languages\e
n\Axxon PSIM.ddi

The full path to the .dbi file

9 Create 
backup 
copy (MS 
SQL)

The button for starting the process of 
creating a backup copy of the database. 
This button is active if the idb.exe utility 
is connected to the MS SQL format 
database

Active Active – the idb.exe utility 
is connected to the MS 
SQL format database

Inactive – the idb.exe 
utility is not connected to 
the MS SQL format 
database
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№ Element 
name

Description Default value Allowed values

10 Restore 
from 
backup 
(MS SQL)

The button for restoring the database 
from a previously created backup

Active Active – the idb.exe utility 
is connected to the MS 
SQL format database

Inactive – the idb.exe 
utility is not connected to 
the MS SQL format 
database

11 Clear 
protocol
s

The checkbox that excludes the Event 
log database from the created database 
backup copy. It is recommended to set 
this checkbox if the size of the Event log 
database is too large, and there is no 
need to include the Event log in the 
backup copy.

The setting is available only for Axxon 
PSIM base database

No Checked – the database 
backup copy does not 
include the Event log 
database

Clear – the database 
backup copy includes the 
Event log database

12 Update 
database

The button for starting the process of 
updating the database structure. The 
structure is updated according to 
the .dbi file specified in the Select dbi-
file field

Active Active – the idb.exe utility 
is connected to the 
Configuration database

Inactive – the idb.exe 
utility is not connected to 
the Configuration 
database

13 Create 
dbi-file

The button for creating a database 
structure .dbi file (template)

Active Active – .dbi file creation is 
allowed

14 The 
Protocol 
informati
on table

The information table that displays the 
progress of database processing: 
converting, structure updating, creating 
backup copy, etc.

Empty Information messages 
about the progress of the 
database processing.

The blue “i” icon indicates 
that the processing step 
has been successfully 
completed

The red “!” icon indicates 
the errors in the 
processing step

A blue tick icon indicates 
the completion of the 
processing
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1.

2.

№ Element 
name

Description Default value Allowed values

15 OK The button for saving the database 
connection parameters and shutting 
down the idb.exe utility

Active Active – saving database 
connection parameters 
and shutting down the 
idb.exe utility is allowed

Inactive – the utility is still 
processing the database

11.4 Using the idb.exe utility
The idb.exe utility allows the administration of the databases of the Axxon PSIM system. Instructions on how to use 
the utility for administering databases are given in Axxon PSIM™ software database management section.

When you switch between databases using the Select data source drop-down list (see Interface elements of the 
idb.exe window), note that the specified parameters for connecting to the currently selected database are partially 
reset. This is due to the Microsoft security policy. In order for the settings in the Connection string field to be saved, 
do the following before you switch to the administration of another database:

Make sure that the database which connection settings should be saved is selected in the Select data 
source list (1).

Click the Configure button (2).

Note.

The Windows Firewall/ICS service is to be enabled to use the idb.exe utility.

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314511486/Appendix+3.+Axxon+PSIM+software+database+management
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3.

4.
5.

6.
7.
8.

In the window that opens, go to the All tab (3).

Left double-click on the Persist Security Info parameter (4).
Set the parameter value to True (5).

Click OK (6).
Click OK on the Data Link Properties window to update the settings and close the window.
Click OK in the IDB utility window to save the settings.

As a result, the next time you switch to the selected database, the settings for connecting to it will not be reset.

11.5 Working with idb.exe utility with the use of keys
It is possible to run idb.exe utility with keys. For this click Start → Run. Type the path to idb.exe utility (C:\Program 
Files (x86)\Axxon PSIM\idb.exe by default) and the required key after / in the appeared window.
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1.
2.
3.

4.

5.

To display keys, supported by the utility, use the command «idb.exe /?».

idb.exe  utility supports the run with the following keys:

«/update» − the key of running the hidden updating of database (uses psim.dbi file).
«/sync» − the key of database synchronization with the source of data.
«/backup» − the key of running the process of creation the backup copy of Axxon PSIM database. Use the 
-protocol option to exclude the Event protocol database from the backup (i.e., the full command in this case 
would be: /backup -protocol).
The backup copy is created to the address «C:\Users\user\Documents\Axxon PSIM». It is used when the 
idb.exe utility is connected to MS SQL database.
«/restore» − the key of running the database recover from the previously created backup copy. It is used 
when the idb.exe utility is connected to MS SQL database.
«/set_cs key=value» − the key of saving the connection string to the system registry (summary on parameters 
of connection to database).

11.6 Extracting event protocol into an individual database
External event protocol is created with the help of the idb.exe utility.

Attention!

If Time and Attendance module is in use (the module is a part of ACFA PSIM subsystem) use the 
RemoteProtocolConnector utility to extract event protocol into a separate database—see Axxon PSIM Web 
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1.
2.

3.

It is necessary to create the protocol database beforehand with the help of the MS SQL Server program. Do the 
following:

Open Microsoft SQL Server Management Studio Express;
Select Databases.

Right-click and select New Database…

Report System. User Guide (the most recent version of this document is available in AxxonSoft 
documentation repository).

Note

To operate the Report System, which is a part of base Axxon PSIM, the method of extracting the event 
protocol into a separate database is used. The method is described in this section, i.e. using the idb.exe 
utility. Configuration of the connection to such protocol DB is required in the Report System, which is a 
part of base Axxon PSIM (see Connecting to the Events Log (PROTOCOL table)).

https://docs.axxonsoft.com/confluence/spaces/ASdoc/pages/84353171/AxxonSoft+documentation+repository
https://docs.axxonsoft.com/confluence/spaces/PSIM100en/pages/235441033/Connecting+to+the+Events+Log+PROTOCOL+table


PSIM 2.0 (english) – Additional utilities for the Axxon PSIM software

The idb.exe utility for converting databases, selecting database templates and making backup copies of databases– 150

4.

5.
6.

1.

Specify the protocol database name in the Database name line in the New Database dialog window.

To create a new protocol database, click the OK button. 
Shut down Microsoft SQL Server Management Studio Express by clicking the Close button in the upper right 
corner of the dialog window.

As a result, the protocol database is created.

To enable the external event protocol, do the following:

Run the idb.exe utility (see Running and shutting down the utility).
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2.

3.

4.

5.

Select the Protocol database from the Select source database drop-down list.

To enable the Protocol database, set the Use checkbox.

As a result, the Configure button becomes active.
To connect to the Protocol database, click the Configure button. As a result, the Data link properties
dialog window appears.
Go to the Provider tab.
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6.

7.
8.

Select the Microsoft OLE DB Provider for SQL Server from the OLE DB Provider(s) list.

Click the Next button. You will be automatically redirected to the Connection tab.
Do the following in the Connection tab:
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a.

b.
c.

Select a server name from the Select or enter a server name drop-down list. 

Specify the user name in the User name field and specify the password in the Password field.
Set the Allow saving password checkbox.
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d.

e.

f.

g.

Go to the All tab.

In the Persist Security Info field, set the True value. This is necessary to correctly save the user 
password.

Select the protocol database in the Select the database on the server drop-down list.

Click the Test Connection button.

Note

Each time you change the server connection parameters, you must set the Persist Security 
Info field value to True.

Note

You must select a database at this step. If you leave the database field blank, after you close 
the Data Link Properties window, the line "Database is not set in connection settings" 
appears in the database description window of the IDB.exe utility and the OK button to save 
changes is inactive.
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h.

i.
9.

10.
11.

12.

If the connection to MS SQL Server is successfully established, then the Test connection succeeded
message appears.

Click the OK button in the message window. The window closes automatically.
Select the dbi file. Click the button next to the Select dbi-file information field.
As a result, the Open dialog window appears.
Select the database structure file C:\Program Files\Axxon PSIM\protocol.dbi.

Click the Update database button to update the database in accordance with the psim.dbi file specified in 
the Select dbi-file field.
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13.

1.
2.

3.

4.

As a result, database update starts. Information about this process is displayed in the Protocol table. 
Database is updated, when there is the Database Updating is completed! message in the Protocol table.
To save Axxon PSIM connection parameters to the Protocol database, click the OK button. As a result the 
dialog window closes automatically.

External event protocol is created and connected.

11.7 Creating the database backup copy
To create the MS SQL database backup copy, use the idb.exe utility. To create the backup copy, do the following:

Run the idb.exe utility (see Running and shutting down the utility).
Select the Basic data MS SQL database from the Select data source dropdown list.

If it is not required to include the Event protocol in the backup copy of the database, set the Clear protocols
checkbox. This checkbox is not available if the vertical solution database is selected.
Click the Create backup copy (MS SQL) button.

Note

Select the vertical solution database to create a backup copy of the vertical solution database. For 
example, for Face PSIM the data source is Face.
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5. As a result, the Save as dialog box appears. Select the address and type in the name of saving backup copy.

a.

b.

Note

While creating the MS SQL database backup copy, the created backup copy will be saved on the 
computer where the database server is installed, in case of Axxon PSIM software and database 
server are located on different computers connected through the network. To save created backup 
copy on the computer where Axxon PSIM is installed, do the following:

Create the folder available through the network on the computer where Axxon PSIM is 
installed. Provide access to the created folder from the computer where the database server 
is installed.
Specify the path to the created folder in the Save as window.
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6.

7.

8.

1.
2.
3.

4.

As a result, the process of backup copy creation starts. Information on this process is given in the Protocol 
information table.

The backup copy is created when the Creation of a backup copy is completed! message appears in the 
Protocol table.

Click the OK button. The dialog box closes automatically.

The MS SQL database backup copy is created.

By default the database backup copy is created at: C:\Documents and Settings\<user name>\My 
documents\AxxonSoft\Axxon PSIM\Data\psim.sql.bak. In case you cannot change the folder for storing the 
database backup copy while the backup copy creation, do the following:

Call the Run function (Start → Run). Type in regedit in the opened dialog box.
Click the OK button. As a result, the Registry editor dialog box opens.
Create the string parameter with the BackupFolder name in the HKLM\SOFTWARE\AxxonSoft\PSIM registry 
thread (see Adding string parameters to the registry).
Set the value of the BackupFolder parameter: type in the address of the folder for storing the database 
backup copy (e.g. C:\Documents and Settings\AVP\Desctop\Backup). 
If it is necessary to store the database copy on the network disk, then the UNC path to the network folder 
(with the recording access) should be specified on the disk in the \\ServerName\ShareName format. Take 

Note

The backup copy (MS SQL) can be created using the macro.

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314511438/Adding+string+parameters+to+the+registry
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a.
b.

5.

6.

7.

1.
2.

into account that all network resources that require additional authentication should be connected using 
the same username as for running the SQL Server service. To find out and/or change the user that runs the 
SQL Server service, do one of the following:

Using the SQL Server Configuration Manager utility.
Run Start – Control panel – Administrative tools – Services, right-click the SQL Server service and 
select Properties in the feature menu. In the opened SQL Server service dialog box, go to the Log On
tab.

As a result, the string parameter of the key with the specified value is created.

Call the Run function (Start → Run). Type in the «C:\Program Files\Axxon PSIM\idb.exe /backup» key in the 
opened dialog box.
Click the OK button.

As a result, the psim.sq.l.bak database backup copy is created in the folder specified as the value of the 
BackupFolder parameter.  

11.8 Restoring database from backup copy
The database backup copy is created using the idb.exe utility (see Creating the database backup copy). Database 
restoring from backup copy is also performed using the idb.exe utility in the following way:

Run the idb.exe utility (see Running and shutting down the utility).
From the Select data source: drop-down list select the MS SQL database – Basic data.

Note

Select the vertical solution database to create a backup copy of the vertical solution database. For 
example, for Face PSIM the data source is Face.



PSIM 2.0 (english) – Additional utilities for the Axxon PSIM software

The idb.exe utility for converting databases, selecting database templates and making backup copies of databases– 160

3.

4.
5.

6.

7.

 Click the Restore from backup (MS SQL) button (1).

Using the standard dialog box for opening files, select the created earlier file with database backup copy.
As a result, the process of database restoring from backup copy will start. Information about process is 
displayed in the Protocol informational table (2).
Restoring is completed when the Restoration from a backup copy is completed! message will be displayed 
in the Protocol table.
To finish the work click the OK button. The window will close automatically (3).

Database restoring from backup copy is completed.
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1.
2.

12 Configuration check tool
The Configuration check tool is designed for checking the settings of all created objects in the Axxon PSIM™ 
software and restoring the correct configuration if any changes occurred. Restoring is performed from the 
configuration template which can be created at any moment in accordance with current settings.

12.1 Starting and shutting down the Configuration check tool
To start the Configuration check tool, do the following:

Go to the Interfaces tab of the System settings dialog box.
Create the Configuration check object on the base of the Display object.
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3.

4.

5.

Go to the settings panel for the Configuration check object.

To configure the position of the Configuration check object, set the coordinates of upper left corner in X:, Y:
fields and values of window’s width and height in W:, H: fields, and select the computer monitor for which 
the coordinates are set.

To save the changes, click the .

As a result the Verifying configuration tool dialog box is displayed.
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To shut down the tool, click the  button on the main control panel of Axxon PSIM software and select the Close 
all menu item;
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1.

2.

3.

4.

12.2 Configuration check tool interface description
The dialog box of the Configuration check tool has four main interface elements:

The toolbar (1).
The tool’s control menu is located here.
The objects tree of Axxon PSIM software (2).
The objects tree of Axxon PSIM software is displayed here. Clicking the left mouse button on any object in the 
objects tree, the configuration of its parameters is displayed in parameters field (points 3-4).
The field of object parameters from Axxon PSIM configuration (3).
The current configuration is displayed in this field. These parameters are not available for editing.
The field of object parameters from a template (4).

Parameters of the selected object from the configuration template field are displayed here. These parameters are 
available for editing.

Note.

At the first start of the Configuration check tool, the current configuration of selected object is displayed in 
this field.
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12.3 Using the Configuration check tool
To start the operation, start the Configuration check tool (see the Starting and shutting down the Configuration 
check tool section).

12.3.1 Creating a template
To create a template in the Configuration check tool, do the following:
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1.

2.

In the objects tree, set the checkboxes next to those objects which parameters configuration will be included 
in a template.

Click the left mouse button upon the object which parameters configuration is to be edited.

As a result there is a list of object parameters with values, available for editing in the parameters from 
template field.

Note.

The set checkbox next to the required object is an obligatory term in order to edit the parameters.

Note.

 In the parameters from Axxon PSIM configuration field there is a list of object parameters with 
values set in Axxon PSIM software. They can not be edited.

Note.

At the first start of the Configuration check tool, the current configuration of selected object is 
displayed in this field.
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3.

4.
5.

6.

7.

Edit the object parameters. To edit the selected parameter, click the left mouse button upon the 
corresponding line with its value and edit it.
Repeat steps 3 for all objects, which parameters configurations are to be edited.
Go to the File menu of the control panel and select the Save template item.

Name a file and select the storage directory in the appeared window.

Click the Save button.

The template is now created.

12.3.2 Downloading and editing the template
To download and edit the template, do the following:
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1.

2.

3.

1.

Go to the File menu on the control panel and select the Load template item.

Select a template file in the appeared window and click the Open button.

The objects tree is displayed as a result. The active checkbox is next to the objects which configuration has 
been saved in the template.

To edit the template, repeat steps 1-7 of the Creating a template section.

The template is now downloaded and edited.

12.3.3 Verifying and correcting the configuration
To verify the current configuration of objects in Axxon PSIM software and restore it from the template, do the 
following:

Download the template for which the object configuration is to be verified in Axxon PSIM software (see the 
Downloading and editing the template section).
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2.

3.

4.

5.

a.

Go to the Configuration menu on the control panel and click the Test button.

As a result the objects which current configuration in Axxon PSIM software differs from that one in the 
template will be marked red in the objects tree. 

To view object parameters in the template which values are different from those ones in the Axxon PSIM
software, click the left mouse button upon the object marked red in the objects tree and go to the 
parameters from the template field.
Click the Distinguish button in the Template field.

As a result the parameters which values are different from those ones in Axxon PSIM software are moved to 
the Differences list.

Correction (if necessary) of these parameter in Axxon PSIM software for those ones from the template may be 
performed in two ways:

Click the Remove differences button in the Template field.
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b. Go to the Configuration menu on the control panel and select the Correct item.

The parameter configuration from Axxon PSIM templates is now verified and corrected.  
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13 Index.exe utility for reindexing archive files

13.1 Function of the index.exe utility
The index.exe utility reindexes archive files with a large array of data.

Another way to perform reindexing of archive files is to shut down Axxon PSIM and completely clear the INDEX folder 
in the VIDEO folder on the disk with the archive. Indexes are rebuilt automatically after you start Axxon PSIM. This 
method is equal to using the index.exe utility.

13.2 Starting and shutting down the index.exe utility
To start working with the utility, run the index.exe file in the Modules64 folder that is located in the Axxon PSIM
installation directory, for example, C: \Program Files\Axxon PSIM\Modules64.

As a result, the window of the index.exe utility opens.

 

To exit the index.exe utility, click the Close  button.

13.3 Working with the index.exe utility

Attention!

In order for Axxon PSIM to start working with new indexes, it is necessary to restart the video.run module or 
restart Axxon PSIM after reindexing.

Attention!
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1.
2.

3.

4.
5.

To reindex archive files after changes to the archive (for example, after copying new video recordings to one or 
several archive disks), do the following:

Start the index.exe utility (see Starting and shutting down the index.exe utility).
In the Archive indexing window, select archive disks for reindexing by setting the checkboxes next to the 
required disks (1).
To select all disks, set the Select all checkbox (2).
To start reindexing, click the Start button (3).

The process of reindexing is displayed in the progress bar (4) and in the field (5).
When the process is complete, close the utility window by clicking the  button.

Reindexing of archive files is complete.

To reindex archive files without using the dialog window, in the command line, start the index.exe utility with 
parameters. For example, the index.exe C, D command reindexes archive files on local disks C and D. To reindex 
archive files on all disks, use the all parameter.

Before you start working with the utility, check the value of the IndexRebuilding parameter in the section 
HKLM\SOFTWARE\AxxonSoft\PSIM\Video for 32-bit systems 
(HKLM\SOFTWARE\Wow6432Node\AxxonSoft\PSIM\Video for 64-bit) of the Windows OS registry: by 
default it must be 0. If the parameter value differs from the default value, you must change it to 0; 
otherwise, the utility won't index the archive.

Note

We recommend starting the process of reindexing using the index.exe utility after shutting down Axxon 
PSIM.

Note

During reindexing, all elements of the utility window are inactive.
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Attention!

In order for Axxon PSIM to start working with new indexes, it is necessary to restart the video.run module or 
restart Axxon PSIM after reindexing.
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14 The shedule.exe utility for creating a replication query file

14.1 The purpose of the shedule.exe utility
The shedule.exe utility is designed for creating a query file on the Server-Receiver while replicating the archive on 
unconnected Servers (see Replicating archive from unconnected servers using the removable storage section).

14.2 Starting and shutting-down the schedule.exe utility
To start the utility start the schedule.exe file in the Tools\Replication folder of the Axxon PSIM installation directory. 
For example:

 C:\Program Files\Axxon PSIM\Tools\Replication\shedule.exe.

 

As the result the dialog window of the schedule.exe utility is opened.

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314510357/Replicating+archive+from+unconnected+servers+using+the+removable+storage


PSIM 2.0 (english) – Additional utilities for the Axxon PSIM software

The shedule.exe utility for creating a replication query file– 175

 

To close the schedule.exe utility, click the  button or select Exit in the File menu.

 

Note.

The error message is displayed at opening the schedule.exe utility when users or the Camera objects are 
not created in the Axxon PSIM software under the Computer/LOCALHOST object corresponding to the 
Receiver. It is needed to create required objects and restart the system.
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4.
5.

6.

7.
8.

14.3 Using the schedule.exe utility

14.3.1 Creating the query file for replication
To create the query file do the following:

Connect the removable storage to the Receiver.
Select the user registered the Axxon PSIM™ software in the Query executor drop-down list (1).

Select the Computer object corresponding to the Data source in the Computer drop-down list (2).
In the corresponding drop-down list select the Camera object the archive of which is to be copied (3).
Specify the time period for which the archive from selected camera is to be copied in the From: and To: 

fields using the mask or calendar that is displayed by clicking the  button (4).
Click the Add button (5).
The task is added to the list (6).

Repeat steps 2-6 for all required Sources.
Save the query file.

The query file is now created.

Note.

Select the task and click the Delete button to delete it from the list (7).
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1.

2.

3.

1.

14.3.2 Saving the query file
To save the query file do the following:

Select Save in the File menu.

Select the removable disk where the query file is to be saved in the drop-down list of the opened dialog box 
(1).

Click the OK button (2). The query file is saved on the selected disk.

The query file is now saved.

14.3.3 Opening the query file
To open the query file do one of the following:

Specify the disk where the query file is. For this:

Note.

 The Removable disks are not found message will be displayed if the removable storage is not 
found while saving the query file.

Note.

 If there is the PSIMBackup folder on the removable storage, then the dialog box asking to delete 
this folder is displayed. Click the OK button.
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Select Open drive in the File menu.

Select the query file in the drop-down list (1).

Click the OK button (2).
The utility detects and opens the query file which is in the root of selected disk.
Select the query file manually. For this:
Select Open file in the File menu.

Select the psim_task.xml file containing the query parameters using the standard opening dialog.

The query file is now opened.

Note.

The Removable disks are not found message will be displayed if the removable storage is not found 
while openning the query file.
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•

15 The AxxonPSIM player utility for viewing and converting the 
video archive

15.1 General information about the AxxonPSIM player utility

•

•

•

•

On the page:

Purpose of the 
AxxonPSIM player utility
Hardware requirements 
for the AxxonPSIM 
player utility
Portable version of the 
AxxonPSIM Player utility
Watch history in the 
AxxonPSIM player utility

15.1.1 Purpose of the AxxonPSIM player utility
The purpose of the AxxonPSIM player utility is to view a video archive recorded using Axxon PSIM or Axxon One (see 
Opening video files, Viewing video using the AxxonPSIM player utility). The utility also allows you to view any video 
files in .mkv, .mov, .mp4, .asf, .flv and .avi formats, both with and without audio (see Opening video files by 
specifying the path in the utility).

Additionally, you can use the utility to:

export video files, see Exporting the Axxon PSIM video archive using the AxxonPSIM player utility;
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• decompress the video archive files packed in .exe, see Unpacking video files in the AxxonPSIM player 
portable utility.

15.1.2 Hardware requirements for the AxxonPSIM player utility
For the proper operation of the AxxonPSIM player utility, the graphics card must support the Direct3D or OpenGL 1.2 
functionality.

15.1.3 Portable version of the AxxonPSIM Player utility
You can download 64-bit portable versions of the AxxonPSIM player utility at http://www.axxonsoft.com/resources/
downloads.php. The portable version of the AxxonPSIM player utility can work without Axxon PSIM or Axxon 
One installed. Working with the portable version of the AxxonPSIM player utility is similar to the version included in 
the Axxon PSIM distribution package.

15.1.4 Watch history in the AxxonPSIM player utility
The utility generates a log file containing the playback history, see Watch history in the AxxonPSIM player utility.

15.2 Starting the AxxonPSIM player utility

•

•

On the page:

Starting AxxonPSIM 
player after Axxon PSIM 
installation
Starting AxxonPSIM 
player portable

15.2.1 Starting AxxonPSIM player after Axxon PSIM installation
To start the AxxonPSIM player utility, run the AxxonPSIM_player.exe executable file in the Player folder from the 
Axxon PSIM software installation directory.

The AxxonPSIM player window opens after starting the AxxonPSIM player utility.

Attention!

Exporting video files in .mov, .mp4, .asf and .flv formats is not supported.

http://www.axxonsoft.com/resources/downloads.php
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4.

 

The AxxonPSIM player utility is now started.

15.2.2 Starting AxxonPSIM player portable
To perform initial start-up of the AxxonPSIM player portable utility, do the following:

Unpack the archive downloaded from AxxonSoft website to any suitable folder. Open the folder.
Run the AxxonPSIM_player_portable.exe executive file. Wait for starting up complete.
Utility files are copied to the C:\Program Files\Player directory. In the Documents folder the AxxonSoft
directory is created. This directory contains Export and ScreenShots folders in which video export and 
frames export is performed on default.

After completing of creating environment the AxxonPSIM player portable utility will be run.

Next run of the AxxonPSIM player portable utility is also performed using the 
AxxonPSIM_player_portable.exe executive file located in the distribution package.

15.3 Opening video files
There are three ways to open video files with the AxxonPSIM player utility:

Note.

On initial start-up of AxxonPSIM player portable utility the Axxon Driver Pack is installed. It can’t be 
removed by standard Windows tools. Axxon Driver Pack is removed automatically when the 
AxxonPSIM player portable utility environment removing.



PSIM 2.0 (english) – Additional utilities for the Axxon PSIM software

The AxxonPSIM player utility for viewing and converting the video archive– 182

1.
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3.

1.

2.

3.
4.

Double left-click on the archive file (file of  *._* type) in  the VIDEO folder.

Specifying the path using which the access to archive files is to be performed in the utility.
Using the command prompt.

15.3.1 Opening video files by specifying the path in the utility
The following ways are to be used to specify the path to archive files:

Disk – access is performed to all files stored on the specified disk. The archive must be stored on the disk 
with all the supplementary files created during the recording including the INDEX folder etc.
Folder – access is performed to all files stored in the specified folder. The archive must be stored in the 
folder with all the supplementary files created during the recording including the INDEX folder etc.
File – a separate archive file or a file in .mkv, .mov, .mp4, .asf, .flv or .avi format will be played back.
Folder with video files – files in .mkv, .mov, .mp4, .asf, .flv or .avi format stored in the specified folder will be 
played back.

To open archive files which are to be viewed with the AxxonPSIM player utility, do the following:

Note

To open files by double clicking they should be associated with the player utility. To perform it, run 
the AxxonPSIM player from the admin login at least once.

•

•

Note

If video files that are to be opened were not recorded, but copied, then start the Convert.exe utility to open 
the archive (see The Convert.exe utility for correcting modification dates of video archives section):

If the archive is created in the same time zone as it is viewed, then start the utility with the fullmode 
parameter:
convert.exe fullmode

If the archive is created in different time zone than it is viewed, then move the archive to the 
current time zone by starting the utility with the following parameters in the command prompt: 
convert.exe fullmode TZ +hh:mm 
where +hh:mm is the time shift between the current time zone and the time zone of the archive.

Otherwise the folders with video files fail to open.

Note

Select the folder that is the source for files to be played back in the .mkv, .mov, .mp4, .asf, .flv and .avi
formats.

https://docs.axxonsoft.com/confluence/display/Int490en/The+Convert.exe+utility+for+correcting+modification+dates+of+video+archives
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1.

2.
3.

a.

Click the  button in the AxxonPSIM player window.

The playback settings panel is opened.

Select the way of opening the file: Disk, Folder, File or Folder with video files (1).
Specify the path to video files:

 If the Disk way is selected then set checkboxes next to thу letters of those disks on which the Axxon 
PSIM software archive is stored.
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b.

c.

d.

4.

If the Folder way is selected then click the  button and specify the folder from which 
the archive is to be viewed using the standard Windows dialog.

If the File way selected then click the  button and specify the archive file using the 
standard dialog of file opening.

If the Folder with video files way is selected then click the  button and specify file 
in .mkv, .mov, .mp4, .asf, .flv and .avi format using the standard Windows dialog.

Click the Refresh button (2). The of list video cameras on which the archive is available by specified path is 
displayed in the playback settings window.

Note

The path to the files can be specified manually by entering it in the corresponding field.
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5.

6.

In the list (3) select the video cameras or files the archive from which is to be viewed. To select several 
cameras or files at a time, left-click them holding the Ctrl key.

Click the Apply button (3).

Playback setting panel is closed. Video images from selected cameras stored in the archive on specified path are 
displayed in the utility window.

 

If several cameras are selected for archive playback, it is possible to make the image from one camera fullsized in 
the utility window. Double click the video image to switch over the full-screen mode. Double click the video image 
again to return the mosaic mode.

Opening the archive files specifying the path is completed.

Note

All found cameras are selected by default. The names of the selected video cameras are highlighted 
with blue. 

Note

Click the   button to switch over the mode of list viewing by rows (one camera in a row).

Note

 Enter the part of camera name in the Search field to search required camera (2).
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15.3.2 Opening video files using the command prompt
It is possible to open video files using the AxxonPSIM player utility from the command prompt.

To open video files input the following in the command prompt:

AxxonPSIM_player.exe --source "File/Folder path". For example, AxxonPSIM_player.exe --source "H:
\VIDEO\05-05-12 18\15._01".

To select all available disks with the archive use the “all” value of the “source” parameter: AxxonPSIM_player.exe --
source "all".

To display the window of the AxxonPSIM player utility over other windows use the “topmost” parameter with “1” 
value when opening video files using the command prompt. For opening in a normal mode use “0” value of this 
parameter. For instance, the AxxonPSIM_player.exe --source "H:\VIDEO\05-05-12 18\15._01" --topmost "1" 
command starts the utility in the displaying over other windows mode. By default the “topmost” parameter has “0” 
value.

To start the AxxonPSIM player utility in a single mode prohibiting simultaneous opening several windows of the 
utility, use the “single” parameter of the command prompt with “1” value. To start using several windows of the 
utility use 0 value of this parameter. For instance, using the AxxonPSIM_player.exe --source "H:\VIDEO\05-05-12 
18\15._01" --single "1" command the AxxonPSIM player utility starts with prohibition of simultaneous opening of 
several utility windows. By default the “single” parameter has “1” value.

To enable the option of titles displaying above video image while playing use the “titles” parameter of the 
command prompt with value 1.To disable titles displaying while playing the video image use value 0 for this 
parameter. On default the titles parameter is 1.

15.4 Configuring the AxxonPSIM player utility
To configure the AxxonPSIM player utility do the following:
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1.

2.
3.

Go to the setting panel of the AxxonPSIM player utility. For this click the  button.

To display a semi-transparent debug window over each image, set the Debug checkbox (1).
To enable deinterlacing set the Deinterlacing checkbox (2). To disable deinterlacing remove this 
checkbox. Deinterlacing allows avoiding artifacts in the video image.
Image with artifacts:

Image with no artifacts:



PSIM 2.0 (english) – Additional utilities for the Axxon PSIM software

The AxxonPSIM player utility for viewing and converting the video archive– 188

4.

5.
6.
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10.
11.

12.

                                                                                                 
To enable the option of frames skipping when there is fast playback set the Skip frames during fast 
forwarding checkbox (3). This functionality is used to reduce the Server load.
To display the utility window over other windows set the Stay on top checkbox (4).
To disable the simultaneous opening of several utility windows set the Deny multiple program instances
checkbox (5).
If it is necessary to display titles above video image while playing the video record, set the Show titles
checkbox (6). Options of titles displaying such as font, color and place are specified by Settings.xml file 
which is located in the folder with video archive (in the VIDEO folder). This file is formed by the 
Captioner object (see the Configuring captions display on a video image section).

If resources of video (disks, folders, files) are to be remembered and selected when the utility is run, then set 
the Remember video source checkbox checked (7). If the checkbox is set unchecked, then video is not 
shown when the utility is run, but when the path to the folder or file with video is selected, the previously 
specified path is shown. If the checkbox is set checked, then when the utility is run video is shown starting 
from the frame at which the viewing was previously stopped.
If the 'stairstep' artifacts appear on video while playing, set the Antialiasing checkbox (8) to eliminate them.
Set the Watermark checkbox (9) to show AxxonSoft watermark over the exported video (see Watermarks).
If it is necessary to display tracks during playback, set the Show tracks checkbox (10).

Click  (11) to open a standard Windows dialog box for specifying the folder to export Axxon 
PSIM archive into (see Exporting the Axxon PSIM video archive using the AxxonPSIM player utility).

Attention!

To use the Settings.xml file, the path to the archive files should lead to the disk or to the folder 
where the Settings.xml file is located (see the Opening video files by specifying the path in the 
utility section). If the Settings.xml file is missing or a direct path to the archive file is specified, then 
the titles will be displayed in the center of the video image. If the path to the archive files leads to 
the exported archive file in the .avi format, then the titles will be displayed according to the 
information from this archive file.

Note

The axis of the titles coordinates is shifted to the right closer to the center of the player's screen in 
order to prevent the titles overlapping on the debug information.

Note

https://docs.axxonsoft.com/confluence/spaces/Int411en/pages/136250824/Configuring+captions+display+on+a+video+image
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13.
a.

b.

•
•
•
•
•
•
•
•
•
•

c.
•
•
•

d.
•
•

e.

f.
14.

From the Camera drop-down list (12), select the camera to which the below settings apply:
From the Title drop-down list (13), select the captions to display over the video from the camera 
while playing.
From the Lens drop-down list (14), select one of the following lens types installed in the camera (see 
also Viewing archive of a fisheye camera):

None
Standard fisheye lens
Auto calibrated
A0**V
A1UST
A8TRT
B0QQV
B4QQV
B5SST
B6SST

From the Position drop-down list (15), select the camera position:
Ceiling
Wall
Floor

From the Display drop-down list (16), select the camera type:
PTZ
Perimeter

In the Frame buffer for decoding drop-down list (17), select the number of frames for decoding: 3 or 
5.
Set the Show title checkbox to enable the selected captions displaying (18).

Click the Apply button (19).

The configuration the AxxonPSIM player utility is complete.

15.5 Viewing video using the AxxonPSIM player utility

15.5.1 The Playback control panel
Archive playback control using the AxxonPSIM player utility is performed in the utility window on the playback 
control panel.

The path to the folder can be entered manually to the corresponding field.
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7.

 

Click the  button to go to the playback control panel.

Elements description of the playback control panel is given below:

 Start the archive playback on cameras on which there are records on specified date. Synchronic 
archive playback is available. 

 Playback stop.

 Playback speed up in two times relatively the current speed if the playback launched (maximum ×16 
speed up is available).
 Go to the next frame if the playback stopped.

 Playback speed down in two times relatively the current speed if the playback launched (maximum 
×16 speed down is available).
 Go to the previous frame if the playback stopped.

 Go to the current record beginnig.

 Go to the current record ending.

 Go to the archive ending in the main time scale. Go to the archive ending of selected camera on 
additional time scale.
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8.

9.

10.

11.

12.

13.

 Go to the archive beginning in the main time scale. Go to the archive beginning of selected camera on 
additional time scale.

 Select active camera for archive playback in full-screen mode if several 
cameras selected for archive playback.

 Saving the screenshot of the utility area displaying camera boxes. Screenshot is saved in C:\Users\
%current user%\Documents\AxxonPlayer\Screenshots directory.

 Printing the screenshot of the utility area displaying camera boxes.

  Specifying time and date for archive record to be played.

 Volume adjustment.

Time and archive marks in the both scales are to be taken into consideration while controlling playback. Their 
description is given in the table below.

Mark Description

 Time mark for archive absence (5) This mark means that there is no compressed archive. The more 
interval without archive, the thicker the mark is

Time mark 1 (1) Time period from archive begin to the current moment

Time mark 2 (2) Time period from the current period to archive ending

Time mark 3 (3) Time of recording start

Time mark 4 (4) Time of recording finish

15.5.2 Archive navigation using the calendar
Archive navigation can be performed using the Calendar tool. This tool is designed to specify the date the archive 
on which is to be played back.
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To specify date of archive viewing do the following:

Click the    or  button to access the Calendar tool (1).

Specify the year by dragging the calendar field left or right (2).
Specify the month by dragging the calendar field up or down (3).
Select the needed day by left-clicking the mouse (4). Days for which records are stored in archive are 
highlighted with white.

Going to the first archive record at the specified date is performed when the required date is selected in the 
calendar.

Date specifying for archive viewing is completed.

15.5.3 Archive navigation using the timescale
You can perform archive navigation using timescales.

Timescales contain color indicators of records presence per period—tracks.

There are the following timescale types in the AxxonPSIM player utility:
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a.

b.

Main timescale (1). This scale displays tracks from all cameras selected for viewing.
Additional timescale (2). This scale displays tracks from the active camera.

You can perform archive navigation in two ways:
By dragging the scale relative to the indicator. When you match the indicator to the point on the 
timescale, the system switches to the recording moment corresponding to this point.
By clicking the left mouse button on the required period on the timescale.

Moving along the main and additional scales is performed synchronously.
If there are no frames for the viewing period, the system displays the last frame on a black background with a red 
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icon indicating the absence of an archive, as shown in the figure below.

It is possible to zoom the timescales. You can zoom in and zoom out using the mouse wheel in the required 
timescale area (see Scaling a video image in the AxxonPSIM player utility).

15.5.4 Scaling a video image in the AxxonPSIM player utility
It is possible to scale viewing video images in the AxxonPSIM player utility.

Zoom in and zoom out of video image size are performed using the scroll wheel in the camera area.
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•
•
•
•
•

Navigation over the blowup video is performed using the mouse cursor moving with holding the middle mouse 
button (wheel) pressed.

15.5.5 Saving the frame from the command prompt
It is possible to export frame from archive using the command prompt. The following parameters of 
AxxonPSIM_player.exe executive file are used:

help – reference on parameters of executive file;
source arg – specifying the video file/catalogue;
channels arg – specifying the video camera id for frame export;
destination arg – specifying the catalogue for frame export;
time – specifying the time of export frame in YYYY-MM-DD HH:MM:SS.ZZZ format.

Example.

« --source "D:\VIDEO" --destination "D:\CmdExportFolder" --channels "1 3 5" --time "2011-11-02 15:40:11.123"»

or

«--source "D:\VIDEO" --destination "D:\CmdExportFolder\UserFrame.jpg" --channels "1" --time "2011-11-02 
15:40:11.123"»

 File names like “dd-MM-yyyy hh-mm-ss-zzz channelID.jpg" are assigned automatically in the first case. In the 
second case file names are specified by the user and it is possible to save the frame in JPG, BMP or PNG formats.

If the channels parameter is not specified, then all existing channels are to be saved both for the video and images.

15.5.6 Watermarks
If a video file was exported using AviExport utility (see The AviExport utility section in Operator’s Guide), a 
watermark will be displayed on the video while viewing it using the AxxonPSIM player utility:

https://docs.axxonsoft.com/confluence/spaces/PSIM100en/pages/235439008/The+AviExport+utility
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15.5.7 Viewing archive of a fisheye camera
Video files of a fisheye camera archive are opened in a common way – see Opening video files.

However, the fisheye video is recorded to Axxon PSIM or Axxon One archive without any conversion, therefore 
conversion parameters are to be set in AxxonPSIM player in order to view such archive video files – see Configuring 
the AxxonPSIM player utility.

After setting the conversion parameters, the video is displayed in the "unfolded" form. When Display: PTZ is set, 
the virtual PTZ format is available during file playback after digital zoom of the video image with the mouse wheel 
by one scale division or more. In this format, click-and-move the left mouse button over the video to change the 
angle of view of the fisheye camera.

Example.

Video without conversion (Lens: None):

Note

A watermark is not added to the video if video was exported in the original format and codec was not 
changed. 
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Video with the following conversion parameters: Lens: Standard fisheye lens, Position: Ceiling, Display: 
Perimeter:

Video with the following conversion parameters: Lens: Standard fisheye lens, Position: Ceiling, Display: PTZ 
(after scrolling the mouse wheel by one scale division):
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15.5.8 Displaying captions on video
If the video file contains captions, you can adjust their display during the video playback in the AxxonPSIM player
utility. When playing back a video with both external and built-in captions tracks, the external captions are disabled 
by default. When playing back a video with the external captions only, they are enabled automatically.

To adjust the captions display, do the following:

Right-click on the viewing area. A window with a list of available captions will open:

Click on the name of the caption that should be displayed. The  icon will appear next to the name of the 
displayed caption:

To disable the captions display, click on the caption name again:
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15.6 Exporting the Axxon PSIM video archive using the AxxonPSIM player 
utility

15.6.1 Order of video archive export
Exporting the archive using the AxxonPSIM player utility is performed in the following way:

Specify the path to the folder into which the archive files are to be exported (see Configuring the AxxonPSIM 
player utility).
Go to the export panel (see Going to the export panel).
Create the export task (see Creating the export task).
Start the archive export process (see Running the archive export).

15.6.2 Going to the export panel

To go to the export panel click the  button. If a video file in .mov, .mp4, .asf and .flv formats is open in the 

utility, this button is disabled and looks like  .
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15.6.3 Creating the export task
To create the export task, do the following:

Select the New export task in the list.

Attention!

For the correct operation of the AxxonPSIM player utility, you can add up to 10 cameras within one export 
task. This limitation is due to the specifics of Windows API.
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a.

Using the mouse, select an image from the required camera and drag it to the export list.

Cameras will be added to the export list (1).

Each export task has a separate window with settings.

To open the settings window, click the gear button  next to the list of cameras.
In the window that opens, in the Container type field, select the container type (a file format 
containing a set of video and audio tracks, subtitles tracks, as well as other service information) for 

•

•

Note

You can create several export tasks, i.e. select several cameras for one task, then create 
another export task and add other cameras to it.

To remove a camera from the list, click the  button.

Attention!

Window with settings is only available for formats different from the Axxon PSIM own format.
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c.

•

•

•

the exported file: avi or mkv.

In the Name prefix of the exported file field, specify the name of the exported file.
To save the changes, click the Apply button. To discard the changes, click the Close button.

Specify the export start and end date in one of the following ways:
Enter the required value in the field manually (2, 5).

 Click the  button and use the Calendar tool (3, 6). Calendar operation algorithm is similar to the 
archive navigation (see Archive navigation using the calendar).

Click the  button (4) and specify the export start date by dragging the time scale relative to 

the indicator (8). Click the  button (7) and specify the export end date by dragging the time 
scale relative to the indicator (8).

Export task creation is complete.

15.6.4 Running the archive export
To start the export, you can do one of the following:

To export all created tasks, click the All tasks button (1).

To export a single task highlighted in the list, click the Current button (2).

The export status is indicated by the progress bar (3).

Export of video archive is completed.

After the export is completed, the files will be saved to the default folder C:
\Users\user\Documents\AxxonSoft\Export\Screenshots. You can change the folder for export in the AxxonPSIM 
player utility settings (see Configuring the AxxonPSIM player utility).

If the archive cannot be exported, an error message will appear describing the problem.

15.6.5 Setting the export parameters in the command prompt
It is possible to set the export parameters from the Windows command prompt. The following parameters of the 
AxxonPSIM_player.exe executive file are used:

help – reference output by parameters of executive file;

Note.

To stop the export, click the  button. In this case, none of the archive files will be exported.
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source arg – specify the video file/catalogue;
channels arg – specify the video camera id for export through the space button;
destination arg – specify the export catalogue;
from arg – specify the start export time in YYYY-MM-DD HH:MM:SS.ZZZ format;
to arg – specify the end export time  in YYYY-MM-DD HH:MM:SS.ZZZ format.

Example of line for export: «--source "D:\VIDEO" --channels "1 3 5" --destination "D:\CmdExportFolder" --from 
"2011-11-02 15:40:05.123" --to "2011-11-02 15:40:17.123"».

15.7 Unpacking video files in the AxxonPSIM player portable utility
In Axxon PSIM, you can export the archive in the .exe format using the AviExport utility (see Operator's Guide, The 
AviExport utility section).

If you have problems playing back the archive exported in the .exe format, you can extract the video from the .exe 
file and watch it separately.

You can do this as follows:

Place the exported .exe file in the same folder as the AxxonPSIM player portable utility.
While in this folder,

Run the command line with the cmd command.
Execute the %PACKED_FILE_NAME% --extract "%VIDEO_FILE_NAME%" command, where

%PACKED_FILE_NAME%—the name of the archive exported in the .exe format;
%VIDEO_FILE_NAME%—the name of the file in the .avi format, which is necessary to obtain 
as a result of unpacking.

As a result, the exported file with the specified name appears in the same folder.

Command examples:

Packed_video.exe --extract "1video.avi" —if the source file is less than 4 GB.

AxxonPSIM_player_portable--executable "1video4GB.exe" --extract "result.avi"—if the source file is larger 
than 4 GB.

Unpacking video files in the AxxonPSIM player portable utility is complete.

15.8 Watch history in the AxxonPSIM player utility
The utility saves the watch history and generates a text file named AxxonPSIM_player.lh (extension — log history). 
The file is located in the C:\Program Files\AxxonSoft\Player folder.

Attention!

If the exported .exe file is larger than 4 GB, it is necessary to execute the 
AxxonPSIM_player_portable --executable "%PACKED_FILE_NAME%" --extract 
"%VIDEO_FILE_NAME%" command, where AxxonPSIM_player_portable is the 
name of the AxxonPSIM player portable utility.

Attention!

The extraction fails if the name of the folder where the AxxonPSIM player portable utility and .exe file are 
located contains Cyrillic characters. To fix it, rename the folder (using Latin characters and digits) and try 
again.

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314508554/Operator+s+Guide
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314509030/The+AviExport+utility
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The file writes the information about viewing the video archive only in Axxon PSIM own format, even if the archive 
was exported into the .exe format and then viewed in the Player. The information about viewing files in other 
formats won’t be written.

The file contains the following information about the watch history:

AxxonPSIM player start date—the date and time of the Player start. This information is written at each new 
start;
Selected cameras:

count—the number of cameras selected for viewing;
date—the date and time of the cameras selection for viewing;

id—camera identifier;
name—the name of the camera;
startTime—the date and the time of the video archive from which you started the viewing.

The system date and time are used.

The file is also written when using the portable version of the utility.

Example of file content:

AxxonPSIM player start date: 10-10-22T19:00:48

Selected cameras: count = 2, date: 10-10-22T19:00:48
id = 1, name = Camera 1, startTime = 05-10-22T17:09:02
id = 2, name = Camera 2, startTime = 05-10-22T17:09:02

Selected cameras: count = 2, date: 10-10-22T19:00:52
id = 1, name = Camera 1, startTime = 05-10-22T17:09:02
id = 2, name = Camera 2, startTime = 05-10-22T17:09:02
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16 The SyncProtocol.exe utility to synchronize event log 
database

16.1 The purpose of the SyncProtocol.exe utility. Starting and shutting-
down the utility

Purpose

The SyncProtocol.exe utility is designed to synchronize Server/Client Event log database with databases of 
other Servers/Clients by command if the auto synchronization is disabled.

The auto synchronization is disabled on the Computer settings panel using the Only local protocols checkbox. If 
this checkbox is set checked, then the auto synchronization is not performed – see Configuring events logging.

Before starting synchronization using the SyncProtocol.exe utility it is required to configure synchronization on the
Computer settings panel by specifying the computers for synchronization and the Event Viewer database 
connection string – see Configuring the Event Viewer databases synchronization.

There is no synchronization with computers for which sending events is disabled in the Architecture tab 
(see Configuring the interaction of distributed system components). If the Send events checkbox is set checked, 
but checkboxes for all the events are set unchecked, then the events that cannot be disabled will be synchronized 
(for instance, SLAVE and macro events).

Starting and shutting-down the utility 

Start the SyncProtocol.exe utility from the Tools folder in the Axxon PSIM installation folder (by default, C:\Program 
Files (x86)\Axxon PSIM\Tools).

The utility dialog box is shown in the figure.

To shut down the SyncProtocol.exe utility click the  button in the upper-right corner of the window.

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314510200/Configuring+events+logging
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314510202/Configuring+the+Event+Viewer+databases+synchronization
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314509912/Configuring+the+interaction+of+distributed+system+components
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16.2 Synchronization of event log database using the SyncProtocol.exe 
utility

Synchronize the event log database using the SyncProtocol.exe utility as follows: 

Preconfigure the system and start the SyncProtocol.exe utility (see The purpose of the SyncProtocol.exe 
utility. Starting and shutting-down the utility).
Click the Synchronize button (1).

The information on the synchronization process is displayed in the Synchronization log field (2).
When the process is completed shutdown the utility by clicking the  button.

The event log database is now synchronized using the SyncProtocol.exe utility.
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17 The FileSystemCheck.exe utility for scanning and checking 
index files

17.1 The purpose of the FileSystemCheck.exe utility. Starting and 
shutting-down the utility

Purpose of the FileSystemCheck.exe utility

The FileSystemCheck.exe utility is used for scanning and checking the index files.

Starting and shutting down the utility

You can start the FileSystemCheck.exe utility from the Tools64 folder in the Axxon PSIM installation directory. For 
example: C:\Program Files\PSIM\Tools64\FileSystemCheck.exe.
As a result, the screen displays the FileSystemCheck.exe utility window.

To shut down the FileSystemCheck.exe utility, click the  button in the upper right corner of the window.

17.2 Working with the FileSystemCheck.exe utility
To work with the FileSystemCheck.exe utility, do the following:

Start the FileSystemCheck.exe utility (see The purpose of the FileSystemCheck.exe utility. Starting and 
shutting-down the utility).
Click the Options button.
Select one or two items from the Options drop-down list:

Only errors if you need to check that the files and folders specified in the index exist;
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Search junk files if you need to find files that don't belong to the archive in the time folders.

Click the Check button.
Select Start from the drop-down list.
As a result of the check, all utility actions are logged in the FileSystemCheck.filesystem.log file. If you 
select Search junk files, the files that don't belong to the archive in the time folders are moved to the LOST 
folder at the <Archive disk>:\VIDEO\LOST path.
Errors will display as follows:
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18 The openRTSP.exe utility for checking RTSP workability
The openRTSP.exe utility is a console application without a graphical user interface. This utility is intended for use 
in scripts to check workability of the RTSP Server module. Please visit http://www.live555.com/openRTSP/ for 
details about the utility.

The openRTSP.exe file is located in the <Axxon PSIM installation directory>\Tools folder.

An example of a script to test the workability of RTSP is given below. This script runs the openRTSP.exe utility by 
timer, then the utility takes 1 sec of video and checks the status of the RTSP Server. If a rejection from the RTSP 
Server itself is received, the StreamingServer.run process is restarted.

function check_cam(addr)
{
  var scmd = "./Tools/openRTSP.exe -V -D 10 -d 1 "+addr;
  DebugLogString("run:"+scmd);
 
  var s = run_cmd_timeout(scmd, 10000);
 
  DebugLogString(s);
  if(s.indexOf("Receiving streamed data")< 0)
  {
    DebugLogString("restarting");
    var msg = CreateMsg();
    msg.StringToMsg("SLAVE|COMP_NAME|EXECUTE|restart<1>,command<streamingserver.run>")
; //change COMP_NAME to the name of the computer where the process runs
    DoReact(msg);
  }
}
 
if(Event.SourceType == "LOCAL_TIMER" && Event.SourceId == "TEST_RTSP")
{
  check_cam("rtsp://127.0.0.1:5544/1"); //the link is formed as described in the 
"Configuring the RTSP Server Module" section
  check_cam("rtsp://127.0.0.1:5545/4");
}

Note.

Create and configure the Timer object for the required check period – see Creating and using the Timer 
object.

http://www.live555.com/openRTSP/
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314511102/Creating+and+using+the+Timer+object
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19 The Automatic Update Service

19.1 Function and operation of the Automatic Update Service
The Automatic Update Service is used to configure the automatic update of Axxon PSIM and vertical solutions in a 
distributed network. The service is installed in addition to the main product and works independently of it.

19.1.1 Service components
There is the update server (installation type is Server (Administrator's workplace)) that distributes the version for 
the update, and the client (installation type is Client (Workstations)) that are dependent servers that receive the 
version from the update server and install it. In addition, the Update manager program is installed to manage the 
updates together with the update server. Thus, you need to select the distributor server and install the Server 
(Administrator's workplace) on it, and install the Client (Workstations) on the servers that need to be 
automatically updated. For details, see Installing the Update Service.

After installation, you need to configure the update server and the clients—see Configuring the update server 
(distributor) in the Update manager and Configuring the client (receiver).

19.1.2 Principle of operation
Once configured, it works as follows:

The clients connect to the update server.
The update server contains a list of available updates.
The automatic update parameters for the clients are configured on the update server using the Update 
manager program.
At some point in time (depending on the settings in the Update manager), the client receives an update task 
in the form of an installation package. This package updates Axxon PSIM on the client. For more details, 
see Configuring the client (receiver).

19.1.3 Requirements for user permissions in Windows OS
The update server is installed in Windows OS as a service, so you must install it with Administrator privileges in 
Windows OS.

Note that the automatic update on the client starts a software installation that can require Administrator privileges 
in Windows OS.

The behavior is as follows:

When updating as a standard user with UAC enabled: during installation there is a start request requiring an 
Administrator password.
When updating as an Administrator with UAC enabled: during installation there is an installation permission 
request.
When updating with UAC disabled: there aren't any additional requests.

Updating Axxon PSIM

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314509768/Updating+Axxon+PSIM
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19.1.4 Collecting information about the Automatic Update Service in the 
Support.exe utility

If necessary, you can collect information about the operation of the Automatic Update Service in The utility for 
collecting configuration data on servers and RWS for the Technical Support. The generated archive contains the 
UpdateService folder containing files of logs, settings, and possible failures in the operation of the client and 
update server.

19.2 Installing, repairing, updating, and removing the Automatic Update 
Service

19.2.1 Installing the Update Service

•
•
•
•
•

On the page:

Distribution package
Installation procedure
Installing the server
Installing the client
Installing server and 
client

Distribution package
To get the current version, contact the AxxonSoft technical support.

The distribution package contains a setup.exe file.

Installation procedure
You must install the Server (Administrator's workplace) on the computer that will distribute updates as the 
update server. You must install the Client (Workstations) on each computer that requires automatic updates in the 
future (that is, on the clients).

Any computer can be an update server even if it doesn’t have Axxon PSIM installed. Any Axxon PSIM servers, Remote 
Administrator’s workstations, and Remote clients can be clients (the differences are described in Configuration 
procedure for servers, clients and remote workstations).

Installing the server
Run the setup.exe file. 
An installation window opens.

Attention!

You must run the installation files as a Windows Administrator.

https://support.axxonsoft.dev/
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314509884/Configuration+procedure+for+servers+clients+and+remote+workstations
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Click the Next button.

A window with the text of the license agreement opens.
Read the license agreement and select I accept the terms of the License agreement.
Click the Next button.
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A window for selecting the installation type opens. 
To install the update server separately, select Server (Administrator's workplace).
Click the Next button.

A window for selecting the installation path opens. By default, the Server (Administrator's workplace) is 
installed in C:\ProgramData\UpdateServer.

Note

You can print the license agreement. To do this, click the Print button.
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You can change the installation path. To do this, click the Browse button and in the window that opens, 
select or create another folder and click the OK button.

After you select the installation path, click the Next button.
The installation process starts, and progress is displayed in the installer window:
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When completed, the Installation Complete window opens.

Click the Finish button.

As a result, the update server is installed in the selected folder, and the Update Service shortcut appears on the 
desktop:
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Installing the client
The client installation is similar to the update server installation described above: you must run the setup.exe file 
and go through the same installation steps. The only difference is step 5, where you must select the Client 
(Workstations) installation type:

By default, the client is installed in the C:\ProgramData\UpdateAgent\ folder.

As a result of the client installation, the icon appears in the system tray:

Installing server and client
The installation of both server and client on the same computer is similar to the update server installation 
described above: you must run the setup.exe file and go through the same installation steps. The only difference is 
step 5, where you must select the Server (Administrator's workplace) and Client (Workstations) installation 
type.
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A window for selecting the installation path for the Server and Client opens. By default, the Server is installed in C:
\ProgramData\UpdateServer\, the Client is installed in C:\ProgramData\UpdateAgent\:

As a result, the server is installed in the selected folder, and the Update Service shortcut appears on the desktop:
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The client is also installed, and the icon appears in the system tray:

19.2.2 Changing the IP address of the update server
When you run the update server for the first time, its IP address and port are automatically detected and written to 
the settings.json file located at C:\ProgramData\UpdateServer\Cfg:

Note

When you run the Update Service for the first time, the IP address and port of the update server are 
automatically detected and written to the settings.json file. If necessary, you can change them—Changing 
the IP address of the update server.
When you install the Update Service, a separate branch 
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Update Service is created in the registry. The branch 
is deleted from the registry when you remove the Update Service (see Axxon PSIM base version, for the 
information on working with the registry, see Working with Windows OS registry).
When you try to install an older version of the Update Service, a warning window opens:

Configuring the update server (distributor) in the Update manager
Configuring the client (receiver)

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314513095/Axxon+PSIM+base+version
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314511425/Working+with+Windows+OS+registry
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If necessary, you can change the IP address and port of the update server manually. To do this, do the following:

Open the settings.json file with any text editor (for example, Notepad).
Enter new values for "Port" and "Ip".
Save the changes in the file.
Restart the Update Server (by default, update_server.exe is located in the C:\ProgramData\UpdateServer 
folder).

As a result, the update server will use the new address written in the settings.json file.

19.2.3 Repairing the Update Service
The repairing process is the same regardless of the installation type: server, client, or server and client.

To repair the Update Service, do the following:

Run the setup.exe file that was in the distribution package that you received (see Installing the Update 
Service).
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In the window that opens, select Repair.

Click the Next button.
The repairing process starts. The progress is displayed in the window.
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The Repair Complete window opens if the repairing process is successful. Click the Finish button.

Repairing the Update Service is complete.

19.2.4 Automatic update of the client using the Update Service
To update the client on the receiving servers, you can use the Automatic Update Service.

To do this, do the following:

Add the installation package of the new version to the Update Service;
Run the update in the same way as the update of Axxon PSIM or its vertical solutions.

For more details, see The Updates tab and The Agents tab.

19.2.5 Removing the Update Service
You can remove the Update Service in the same way regardless of the type of installation: server, client, or server 
and client.

To remove the Update Service, do the following:

Run the setup.exe file that was included in the distribution package (see Installing the Update Service).
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In the window that opens, select Remove.

Click the Next button.
Removal process starts. The progress is displayed in the window.
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4. When completed, the Removal Complete window opens. Click the Finish button.

Removing the Update Service is complete.

19.2.6 Installing, repairing, updating, and removing the Automatic Update Service 
in the quiet mode

You can install, update, and remove the Update Service in the quiet mode, that is, without the user interface.

The criterion for the completion of the setup program is the termination of the Redist.exe process in the Windows 
Task Manager.

This type of installation occurs when you specify the parameters of the setup.exe file in the Windows command line. 
The parameters of the setup file are listed in the table.

Parameter of the setup file in the 
command line

Description

/x  Remove the Automatic Update Service 

/uninstall Remove the Automatic Update Service 

Note

You may need to restart your system while the setup program is running. After you restart the system, the 
installation continues automatically.
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Parameter of the setup file in the 
command line

Description

/qn Install/update the Automatic Update Service

/quiet Install/update the Automatic Update Service

/norestart Disable automatic system restart during installation

/LANG=”en” Select English language for the setup program

/INSTALLTYPE="Client" Select the Client (Workstations) installation type

/INSTALLTYPE="Server" Select the Server (Administrator's workplace) installation type

/INSTALLTYPE="ClientAndServer" Select the Server (Administrator's workplace) and Client 
(Workstations) installation type

AGENTNSTALL='1' Installation as a service

/CMD="[commands]" Values of properties of the basic setup program, where 
commands is [Property]=\"[Value]\" or [Property]='[Value]'. The 
available properties of the setup program are listed in the table 
below

/CMD="UPDATEAGENTFOLDER=\"path\"" Select the installation path for the Client 
(Workstations) installation type

 /CMD="INSTALLFOLDER=\"path\"" Select the installation path for the Server (Administrator's 
workplace) installation type

/
CMD="INSTALLFOLDER=\"path\" UPDATEAG
ENTFOLDER=\"path\""

Select the installation path for the Server (Administrator's 
workplace) and Client (Workstations) installation type

Example of running the installation/update of the Automatic Update Service in the quiet mode:

setup.exe /quiet /LANG="en" /INSTALLTYPE="Server" /CMD="INSTALLFOLDER=\"c:server\""

As a result of this action, the setup.exe file is launched with the following parameters:

The setup program installs the Update Service in the quiet mode (/quiet).
The language of the setup program is English (/LANG=”en”).
Type of installation is Server (Administrator's workplace) (/INSTALLTYPE="Server").
The installation is performed with the following property (/CMD=): the installation path is c:server 
("INSTALLFOLDER=\"c:server\"").

Example of running the program to remove the Automatic Update Service in the quiet mode:
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setup.exe /uninstall /quiet /norestart

As a result of this action, the setup.exe removal file is launched with the following parameters:

The setup program uninstalls the Update Service (/uninstall).
The setup program uninstalls the Update Service in the quiet mode (/quiet).
Automatic system restart during uninstallation is disabled (/norestart).

Installing, repairing, updating, and removing the Update Service in the quiet mode is complete.

19.3 Configuring the update server (distributor) in the Update manager
To configure the update server and automatically update the clients, use the Update manager program that is 
usually installed with the update server Server (Administrator's workplace).

To run it, you can either use a shortcut on the desktop or run the update_manager.exe file in the folder in which the 
server was installed.

This section describes the interface and main functions of the Update manager:

The Primary server address—field with the IP address of the update server.
The Updates tab—list of the available update packages. You can also add new packages.
The Agents tab—list of the connected client. You can also update them.
The Activity tab—list of computers on which the update is in progress, completed, or scheduled.
The Journal tab—list of all actions on the update server.

19.3.1 The Primary server address
At the top of the window, there is a field with the current IP address and port of the update server. The default is 
port 30900. To change the server address, enter a new address in the Update server ip address field and click 
the Refresh button:

Entry format: IP address and port separated by a colon.

19.3.2 The Updates tab
The Updates tab lists the available update files and their length:

Note

When you run the Update Service for the first time, the IP address and port of the update server are 
automatically detected and written to the settings.json file. If necessary, you can change them—
see Changing the IP address of the update server.
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To add a new update package, do the following:

Click +:

Select a package depending on the file type:
Add file: a standard Windows File Explorer window opens in which you need to specify the path to 
the zipped update package.
Add url: in the window that opens, enter the link to the file and click Add. Requirements:

the direct link to the file, that is, the link must lead to a direct download of the installation 
package in ZIP format;
the link with public access, that is, no authorization required to download.

As a result, the selected packages appear in the list.

To delete a package, select it in the list with a mouse and click .
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19.3.3 The Agents tab
The Agents tab displays a list of clients that are connected to the server. On this tab, you can configure and run 
automatic updates for each client.

The list of clients
The list of clients is a table of all clients that have connected to the server at least once. It contains the following 
information about each client:

Name is the name of the computer on which the client is installed.
Status is the status of the computer. The computer can be available (Ready) or not available (No 
connection).
Product status is the status of the installed software package: running (On) or not (Off).
Installed products is the list of versions of the installed software components.

Configuring and running updates
From the Update archive drop-down list, select one of the available update packages.

In the Timeout (seconds) field, set the update timeout in seconds—the time in which the installation 
process must be completed. If the installation isn’t completed within this time, it is forced to stop. The 
default value is 3600 seconds.
Set the checkboxes next to the clients on which you want to perform the action from the drop-down list (see 
step 6). To select all clients, set the Select all checkbox.
If you want to run the download and update at a scheduled time, set the date and time in the corresponding 
Download at and Update at fields. By default, the current time is set.

In the SQL username and SQL password fields, specify the username and password to access the database.
From the drop-down list, select the action you want to perform on the selected clients (see step 3). You can 
also open the list of actions by right-clicking any client.

Note

You can schedule the download and update for different dates and times.
You can set only the current time or future time in the Download at and Update at fields.
If the update time is earlier than the download time, the update begins immediately.
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Update—install the selected update.
Uninstall/Update—uninstall the current version of Axxon PSIM and install the selected update.
Repair—repair Axxon PSIM.
Restart OS—restart the operating system.
Start/Restart product—if Axxon PSIM isn’t running on the client, it starts. If Axxon PSIM is running, it 
restarts.
Remove agent—remove the client from the list regardless of whether it is connected or not. The next 
time the client connects to the server, it appears in the list again.

Click the Run button.

19.3.4 The Activity tab
The Activity tab displays the computers with the clients on which the update is in progress or completed 
(the Updating table), as well as the computers on which the update is scheduled (the Queue table):

The following information is displayed for each operation:

Created—date of creation.
Computer name—name of the computer with the installed client.
Command—type of an operation:

Run—start the update,
Restart—restart the computer,
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StartProduct—start Axxon PSIM.
Status—status of the update downloading:

If the update download is in progress, "Downloading" and the download percentage is displayed;
If the status is "Waiting", the update has been downloaded and is waiting for the time specified for 
download.

Details—details about an operation. The details depend on an operation type and can be the following:
Error—error and its description,
Started at—start time,
Completed at—completion time,
Duration at—duration,
Status: "Running"—update is in progress, "Finished successfully"—update is successfully completed, 
"Canceled"—operation was canceled by an operator, "Faulted"—failure or error during operation 
execution.

19.3.5 The Journal tab

The Journal tab displays a list of all actions on the update server. At the top, there is a selection of dates and 
statuses that you can use to filter the journal.

To display the journal, do the following:

In the From and to fields, select the period to display the actions (1).
Set the checkboxes next to those operation statuses that you want to display (2).
Click the Query button (3).

As a result, the table displays the list of actions, taking into account the set filters. If there are several pages of the 
journal, you can navigate through them (see the numbering on the screenshot):

4—go to the first page;
5 and 8—previous/next page;
6—number of the displayed page;
7—number of pages;
9—go to the last page.

Note

You can adjust the height of the Updating and Queue tables by dragging the gray bar between them.

Note

When you go to the Journal tab, information about the status of running tasks is automatically updated.
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The journal contains information about all operations. The Activity tab contains information about operations that 
are running (see The Activity tab).

19.4 Configuring the client (receiver)
In each update agent, you must specify the update server. To do this, do the following:

Double-click the icon   in the tray.

In the Update agent window that opens, click the  .
As a result, the Server field becomes editable. Enter the IP address and port of the update server separated 
by a colon in this field:

Click the Set button.

As a result, the window displays information about the connected update server and its status—ONLINE or 
OFFLINE:

 button
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19.4.1 General update procedure on the client

The client receives the update task from the Update manager.
The client requests from the server the installation package with the required version in ZIP format, 
downloads it, and unzips it.
Then the update runs in the quiet mode:

If Axxon PSIM is running at this time, the client stops it;
The client runs the update;
After a successful update, if it was specified during configuration that Axxon PSIM must be restarted, 
the client restarts it. It is also possible to restart the computer if this was specified.

After the update, the client deletes the installation package.

Special cases:

If an update fails (for example, installation error, update cancellation, or computer shutdown), the update is 
considered completed, and the client deletes the installation package. A new run in the Update Service
is required to update again.
If the client receives an installation package with an older version, it tries to install that version, but 
ultimately the current version remains unchanged.

19.4.2 Features of the client (update agent)
The bottom part of the Update agent window displays information about the client (update agent):

Attention!

The update parameters (time, Axxon PSIM start, and so on) depend on the selected settings in the Update 
manager (see Configuring the update server (distributor) in the Update manager).
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If you right-click the tray icon, a dialog window opens:

If you click Exit, the update agent stops. If you click Open log folder, a folder with the logs of the update agent 
opens.

To restart the update agent, go to its installation folder and run the update_agent.exe file.

Click   to hide the Update agent window without stopping it.



PSIM 2.0 (english) – Additional utilities for the Axxon PSIM software

ArchProbe console utility– 233

1.

2.

a.

20 ArchProbe console utility
You can use the ArchProbe console utility to check the integrity of video archive files recorded in the internal Axxon 
PSIM format.
The utility is located in the <Axxon PSIM installation folder >\Tools.

For the utility operation, do the following:

Run the command line using the cmd command to the C:Program Files (x86)\Axxon PSIM\Tools utility folder.

Specify the path to the folder with archive recordings or to a specific file.
To simplify the export in the ArchProbe utility, you can check the integrity of video frames by displaying the 
frame hash and title text.
Example of commands:

To check the integrity of video frames:

C:\Program Files (x86)\Axxon PSIM\Tools>ArchProbe -p "E:\VIDEO\20-06-25 
08"



PSIM 2.0 (english) – Additional utilities for the Axxon PSIM software

ArchProbe console utility– 234

b. To check titles:

C:\Program Files (x86)\Axxon PSIM\Tools>ArchProbe -p "E:\VIDEO\20-06-25 
08" --titles

As a result, the system displays the information about each frame of the specified video archive.
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